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Copyright
© 2001 Roxio, Inc. All rights reserved. No part of this publication may be reproduced, 
stored in a retrieval system, or transmitted in any form or by any means, electronic, 
mechanical, photocopying, recording or otherwise, without the prior written consent 
of Roxio, Inc., 461 South Milpitas Blvd., Milpitas, CA 95035.

Trademarks
Roxio, the Roxio logo, GoBack, the GoBack logo, are trademarks of Roxio, Inc., which 
may be registered in some jurisdictions.

Windows 95, Windows 98, Windows NT, Windows 2000, and Windows Me are 
trademarks of Microsoft Corporation in the US and other countries, used under 
license.

All other company or product names are trademarks and/or registered trademarks of 
their respective owners.

Changes
The material in this document is for information only and is subject to change 
without notice. While reasonable efforts have been made in the preparation of this 
document to assure its accuracy, Roxio, Inc. assumes no liability resulting from errors 
or omissions in this document, or from the use of the information contained herein.

Roxio reserves the right to make changes in the product design without reservation 
and without notification to its users.

Disclaimer
IF THIS PRODUCT DIRECTS YOU TO COPY MATERIALS, YOU MUST HAVE 
PERMISSION FROM THE COPYRIGHT OWNER OF THE MATERIALS TO AVOID 
VIOLATING THE LAW WHICH COULD RESULT IN DAMAGES OR OTHER 
REMEDIES.
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Roxio Product Support

Unlimited Complimentary Self Help Options

If you have questions about installing or using your Roxio products, please check this 
manual or user guide first, you will find answers to most of your questions there. If 
you need further assistance, please check support at http://www.roxio.com for 
frequently asked questions, an extensive database of related articles, troubleshooting 
tips, and more.

Limited Complimentary Technical Support Assistance

Ninety days of technical support assistance is available with the purchase of Roxio, 
Inc. software (OEM product is excluded). To receive technical support assistance, you 
will need the Technical Support Identification (TSID) number found on the white 
barcode-type label included inside the box with your product. The TSID helps us 
provide more efficient service by accurately identifying your product and support 
status. Please affix your TSID here or in another safe place—you will need it for 
complimentary support!

E-mail and telephone assistance is available to purchasers of Roxio products which 
include a TSID.

For worldwide customers (Americas, Europe, Japan, Asia, and Australia) preferring 
Email (webmail) assistance, please submit your question to Roxio’s Technical Support 
Specialists at http://ask.roxio.com. (English only)

For customers preferring telephone assistance (connect and toll charges apply), please 
have your computer running and close by the phone and call us at:

■ In North America call +1 408-934-7283, Monday-Friday, 6:00 a.m.-5:00 p.m., 
Pacific Time, excluding Roxio holidays.

■ In Europe call +49 2405-4508-80, Monday-Friday 10:00-12:30 & 13:30-16:30, 
Central Europe Time, excluding Roxio holidays.

■ In Japan call +81 3-5992-0362, Monday–Friday 9:00 A.M. – 12 P.M. 
& 1:00 P.M. – 6:00 P.M., JST – excluding Roxio holidays.  (Japanese only)

■ In Asia (except for Japan) and Australia there is no local telephone support 
available, please refer to the email support mentioned above or call 
+1 408-934-7283, Monday–Friday, 6:00 A.M. to 5:00 P.M., Pacific Time – excluding 
Roxio holidays.
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Fee-based Technical Support Options

Fee-based Support is available for those customers whose TSID has expired or who 
bought product not eligible for complimentary support.  Please call +1 408-934-7283, 
Monday–Friday, 6:00 A.M. to 5:00 P.M., Pacific Time – excluding Roxio holidays.  
(English only)

Customer Service

For presales information, please call:

■ In North America call +1 866-280-ROXI (7694), Monday–Friday, 6:00 A.M. 
to 5:00 P.M., Pacific Time – excluding Roxio holidays.

■ In all other locations call the technical support numbers provided above.

For all other inquiries, please call:

■ In North America call +1 408-946-4949 or +1 866-279-ROXI (7694), 
Monday–Friday, 6:00 A.M. to 5:00 P.M., Pacific Time – excluding Roxio holidays.

■ In all other locations call the technical support numbers provided above or 
+1 408-946-4949, Monday–Friday, 6:00 A.M. to 5:00 P.M., Pacific Time – excluding 
Roxio holidays.



v

END-USER LICENSE AGREEMENT FOR ROXIO SOFTWARE

IMPORTANT - READ CAREFULLY: This Roxio End-User License Agreement 
("Agreement") is a legal agreement between you (either an individual or a single 
entity) and Roxio, Inc. ("Roxio"), for the GoBack product, which includes computer 
software and may include associated media, printed materials, and "online" or 
electronic documentation ("PRODUCT"). The PRODUCT also includes any 
updates and supplements to the original PRODUCT provided to you by Roxio. 
Any software provided along with the PRODUCT that is associated with a separate 
end-user license agreement is licensed to you under the terms of that license 
agreement. By installing, copying, downloading, accessing or otherwise using the 
PRODUCT, you agree to be bound by the terms of this Agreement. If you do not 
agree to the terms of this Agreement, do not install or use the PRODUCT; you may, 
however, return it to your place of purchase.

SOFTWARE LICENSE

The PRODUCT is protected by copyright laws and international copyright treaties, as 
well as other intellectual property laws and treaties. The PRODUCT is licensed, not 
sold.

1. GRANT OF LICENSE.

This Agreement grants you the following rights:

■ Installation. You may install and use one copy of the PRODUCT on a single 
computer, including a workstation, terminal, or other digital electronic device 
("COMPUTER").

■ Storage or Network Use. You may also store or install a copy of the PRODUCT 
on a storage device, such as a network server, used only to install or run the 
PRODUCT on your other COMPUTERS over an internal network; however, 
you must acquire and dedicate a license for each separate COMPUTER on or 
from which the PRODUCT is installed, used, accessed, displayed or run. A 
license for the PRODUCT may not be shared or used concurrently on different 
COMPUTERS.

■ Site License. If you have acquired this Agreement as part of a site license, you 
may install and use additional copies of the computer software portion of the 
PRODUCT up to the number of copies specified above as "Licensed Copies."

■ Restrictions. All rights not expressly granted herein are reserved by Roxio.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.

■ Academic Version Software. If the PRODUCT is identified as "Academic 
Edition" or "AE," you must be a "Qualified Educational User" to use the 
PRODUCT. If you are not a Qualified Educational User, you have no rights 
under this Agreement. To determine if you are a Qualified Educational User, 
please contact Roxio, Inc., 461 South Milpitas Boulevard, Milpitas, California 
95035.

■ Not for Resale Software. If the PRODUCT is labeled "Not for Resale" or 
"NFR," then, notwithstanding other sections of this Agreement,  your use of 
the PRODUCT is limited to use for demonstration, test, or evaluation purposes 
and you may not resell, or otherwise transfer for value, the PRODUCT.
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■ Limitations on Reverse Engineering, Decompilation and Disassembly. You 
may not reverse engineer, decompile, or disassemble the PRODUCT, except 
and only to the extent that such activity is expressly permitted by applicable 
law notwithstanding this limitation.

■ Separation of Components. The PRODUCT is licensed as a single product. Its 
component parts may not be separated for use on more than one COMPUTER.

■ Limitations on Use. You may not modify, adapt, translate, loan, resell for 
profit, distribute, network, rent, lease or create derivative works based upon 
the PRODUCT or any copy, except as expressly provided in Section 1 above.

■ Trademarks. This Agreement does not grant you any rights in connection with 
any trademarks or service marks of Roxio, Inc.

■ Termination. This license is effective until January 1, 2045, unless terminated 
earlier. You may terminate the license at any time by destroying the PRODUCT 
and all related documentation together with all copies or modifications in any 
form. Roxio will have the right to terminate this Agreement if you fail to 
comply with the terms and conditions of this Agreement. Upon any 
termination, you must destroy all copies of the PRODUCT and all of its 
component parts and any copies or modifications in any form.

3. UPGRADES.

If the PRODUCT is labeled as an upgrade, you must be properly licensed to use a 
product identified by Roxio as being eligible for the upgrade in order to use the 
PRODUCT. A PRODUCT labeled as an upgrade replaces and/or supplements the 
product that formed the basis for your eligibility for the upgrade. You may use the 
resulting upgraded product only in accordance with the terms of this Agreement. If 
the PRODUCT is an upgrade of a component of a package of software programs that 
you licensed as a single product, the PRODUCT may be used and transferred only as 
part of that single product package and may not be separated for use on more than 
one COMPUTER.

4. COPYRIGHT.

All title and intellectual property rights in and to the PRODUCT (including but not 
limited to any images, photographs, animations, video, audio, music, text, and 
"applets" incorporated into the PRODUCT), the accompanying printed materials, and 
any copies of the PRODUCT are owned by Roxio or its suppliers. All title and 
intellectual property rights in and to the content which may be accessed through use 
of the PRODUCT is the property of the respective content owner and may be 
protected by applicable copyright or other intellectual property laws and treaties. 
This Agreement grants you  no rights to use such content. All rights not expressly 
granted are reserved by Roxio.

5. LIMITED MEDIA WARRANTY.

Roxio warrants that the media on which the PRODUCT is distributed is free from 
defects for a period of thirty (30) days from the date of delivery of the PRODUCT to 
you, the end user. ROXIO DOES NOT AND CANNOT WARRANT THE 
PERFORMANCE OR RESULTS YOU MAY OBTAIN BY USING THE  PRODUCT OR 
ACCOMPANYING  DOCUMENTATION.  EXCEPT FOR THE FOREGOING 
LIMITED WARRANTY, ROXIO MAKES NO WARRANTIES, EXPRESS OR IMPLIED, 
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AND SPECIFICALLY DISCLAIMS ALL WARRANTIES OF NONINFRINGEMENT 
OF THIRD PARTY RIGHTS, MERCHANTIBILITY, AND FITNESS FOR A 
PARTICULAR PURPOSE. Some states do not allow the exclusion of implied 
warranties or limitations on  how long an implied warranty may last, so the above 
limitations may not apply to you. This warranty gives you specific legal rights and 
you may also have other rights which vary from state to state.

6. LIMITATION OF LIABILITY.

IN NO EVENT WILL ROXIO BE LIABLE TO YOU FOR ANY SPECIAL, INDIRECT, 
CONSEQUENTIAL OR INCIDENTAL DAMAGES, INCLUDING ANY LOST 
PROFITS, LOST DATA, OR LOST SAVINGS, EVEN IF ROXIO HAS BEEN ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER 
PARTY. Some states do not allow the exclusion or limitation of special, incidental or 
consequential damages, so the above exclusion or limitation may not apply to you.

7. LIMITATION OF REMEDIES.

Roxio's entire liability and your exclusive remedy shall be, at Roxio's option : (a) the 
replacement of any media not meeting Roxio's limited warranty which is returned by 
you; or (b) if Roxio or its distributor is unable to deliver replacement media which is 
free of defects in materials or workmanship, you may terminate this Agreement by 
returning the PRODUCT, and the purchase price you paid will be refunded.  If you 
have purchased this PRODUCT bundled with a computer hardware or software 
product, you must return the PRODUCT to the computer hardware or software 
manufacturer.  THE FOREGOING STATES THE SOLE AND EXCLUSIVE REMEDIES 
ROXIO WILL PROVIDE FOR BREACH OF WARRANTY.

8. CONFIDENTIALITY.  

You agree to maintain the PRODUCT in confidence and that you will not disclose the 
PRODUCT to any third party without the express written consent of Roxio.  You 
further agree to take all reasonable precautions to preclude access of unauthorized 
persons to the PRODUCT.

9. INDEMNITY. 

You agree that Roxio shall have no liability whatsoever for any use you make of the 
PRODUCT. You shall indemnify and hold harmless Roxio from any third party 
claims, damages, liabilities, costs and fees (including reasonable attorney fees) arising 
from your use of the PRODUCT as well as from your failure to comply with any term 
of this Agreement.

10. BACKUP COPY.

After installation of one copy of the PRODUCT pursuant to this Agreement, you may 
keep the original media on which the PRODUCT was provided by Roxio solely for 
backup or archival purposes. If the original media is required to use the PRODUCT 
on the COMPUTER, you may make one copy of the PRODUCT solely for backup or 
archival purposes. Except as expressly provided in this Agreement, you may not 
otherwise make copies of the PRODUCT or the printed materials accompanying the 
PRODUCT.
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11. U.S. GOVERNMENT RESTRICTED RIGHTS.

The PRODUCT and documentation are provided with RESTRICTED RIGHTS. Use, 
duplication, or disclosure by the Government is subject to restrictions as set forth in 
subparagraph (c)(1)(ii) of the Rights In Technical Data and Computer Software clause 
at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer 
Software - Restricted Rights at 48 CFR 52.227-19, as applicable. The manufacturer is 
Roxio, Inc., 461 S. Milpitas Blvd., Milpitas, California 95035.

12. EXPORT RESTRICTIONS.

You acknowledge that the laws and regulations of the United States and other 
countries may restrict the export and re-export of the PRODUCT.  You agree that you 
will not export or re-export the PRODUCT or documentation in any form in violation 
of applicable United States and foreign law.

Export of any information from the Roxio web site outside of the United States is 
subject to all U.S. export control laws. You will abide by such laws and also to the 
provision of the U.S. Export-Re-export Requirements and Enhanced Proliferation 
Control Initiative set forth here. You and your organization will not sell, license, or 
otherwise provide or ship Roxio products or technical data (or the direct product 
thereof) for export or re-export to the embargoed countries listed below: 

Cuba, Iran, Iraq, Libya, North Korea, Syria, Sudan, and the Republic of Serbia

You also agree that unless you receive prior authorization from the U.S. Department 
of Commerce, you shall not transfer, export or re-export, directly or indirectly, any 
Roxio technology or software (or the direct product of such technology or software or 
any part thereof, or any process or service which is the direct product of such 
technology or software) to any of the following nations or nationals thereof: 

Albania, Armenia, Azerbaijan, Belarus, Bulgaria, Cambodia, Cuba, Estonia, Georgia, 
Iran, Iraq, Kazakhstan, Kyrgystan, Laos, Latvia, Libya, Lithuania, Moldova, 
Mongolia, North Korea, People's Republic of China, Republic of Serbia, Romania, 
Russia, Sudan, Syria, Tajikistan, Turkmenistan, Ukraine, Uzbekistan, and Vietnam.

You agree not to transfer, export or re-export Roxio products, technology or software 
to your customers or any intermediate entity in the chain of supply if our products 
will be used in the design, development, production, stockpiling or use of missiles, 
chemical or biological weapons or for nuclear end uses without obtaining prior 
authorization from the U.S. Government. 

13. MISCELLANEOUS

This Agreement is governed by the laws of the State of California.

Should you have any questions concerning this Agreement, or if you desire to contact 
Roxio, please write: Roxio Legal Department, 461 S. Milpitas Blvd., Milpitas, 
California 95035.
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Welcome
GoBack is a remarkable tool that integrates itself into the operating 
system to protect you from data loss. This includes the everyday 
“oops” that can occur from user error or software problems, deleted 
or overwritten files, virus attacks, problems with software 
installations, and even system crashes. With GoBack installed, you 
can easily back out of trouble, regardless of whether the problem 
was caused by you, or by software on your machine. Even if your 
system crashes and will not boot to Windows, you can still recover 
your system’s data.

When it is enabled, GoBack keeps track of every event you create 
that affects your hard disk. Due to this, GoBack allows you to 
retrieve specific files or entirely restore your hard disk.

GoBack is not a backup product because, unlike backup products, 
GoBack does not involve copying data to a separate tape or disk. 
Thus, you do not need to stop and make a backup in order to 
reclaim data created at a certain time in the past. More importantly, 
you can restore to any point in time, not just to the time at which you 
created a backup.
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About GoBack Personal and Deluxe Editions
GoBack is revolutionary system recovery software designed for 
corporate, educational, IT, consumer, and other professional 
environments. With the Personal Edition, users receive GoBack’s 
award-winning primary system protection and recovery features. 
With the Deluxe Edition, users receive all the Personal Edition 
features plus key additional features like powerful Password 
Protection, File Recovery and Rescue, Auto-Revert and other exciting 
features. Personal Edition users can easily upgrade to the Deluxe 
Edition.

Password Protection
Password protection, included with the Deluxe Edition only, is 
essential for corporate IT environments. Password protection keeps 
end-users from accessing historic information logged by GoBack 
(original and deleted files) and reserves key retrieval and revert 
privileges for the system administrator.

For more information, see Passwords on page 4-7.

Auto-Revert
Also a Deluxe Edition-only feature, Auto-Revert lets you 
automatically “roll back” your computer to a “clean” state on a 
scheduled basis (nightly, weekly, etc.) and/or on logoff or system 
shutdown. Auto-Revert can eliminate virtually all system reloads 
and time spent on getting computers operational after users have 
left files on the hard disk, changed system settings, inadvertently 
introduced viruses, deleted critical files, or installed applications. 
Auto-Revert is a useful tool to manage publicly accessible 
computers, such as those in computer labs, libraries, Internet cafés, 
etc. Auto-Revert is also ideal for corporate training labs, computers 
used for demos, and kiosks found in retail stores.

To learn more, see Auto-Revert on page 4-8.
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What GoBack Can Do for You
GoBack provides four essential services. It lets you:

■ Revert your hard disk to an earlier time.

■ (Deluxe Edition) View your hard disk as it was in the past.

■ (Deluxe Edition) Retrieve specific files from the past.

■ (Deluxe Edition) Rescue selected files after doing a revert.

When you view or revert your hard disk to an earlier time, you 
essentially specify a date and time. On the other hand, when 
retrieving an old version of a specific file (Deluxe Edition), GoBack 
scans its historical data and generates a list of available versions, 
each corresponding to a time in the past.

As GoBack monitors and records all information being written to 
your hard disk(s), it provides you with a number of ways to view, 
copy, or access the information it has recorded.

Revert Your Hard Disk to an Earlier Time
There are three primary reasons why you would revert your entire 
hard disk to an earlier time.

■ You may have installed new software or made some 
modification such that your computer no longer works 
properly (for example, it will not boot). Perhaps you added 
new hardware, following the instructions to add the device 
drivers, but something went wrong, and although you can 
physically remove the new hardware, you need to “undo” the 
system changes to get back to where you were.

■ Your computer is generally working, but you would like to 
undo a recent change to the system and you do not know what 
files to restore. Perhaps you started reading your e-mail, and as 
you did, you printed it out and delete it, only later to find that 
the printer was out of ink. Ordinarily, you would be out of luck 
and the e-mail would be gone. However, with GoBack you can 
revert your entire hard disk to before you deleted the e-mail 
and it will be back.
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■ You received a virus in an e-mail that, when you opened the 
e-mail, infected your hard disk. Again, normally this could 
mean hours tracking down the infected files. But with GoBack, 
you can revert your hard disk to a time before you received the 
e-mail and make your system virus-free again. Also, with the 
Deluxe Edition’s File Rescue feature, you could retrieve files 
that you changed after the virus infected your system.

The common thread in these examples is that you really do not 
know what specific data to restore in order to back out of a problem. 
Or even if you do, it is often faster and easier to revert everything to 
some time in the past.

View Your Hard Disk as it was in the Past
Deluxe Edition users may choose to view their hard disk as it was in 
the past. You would do this for the purposes of retrieving an entire 
folder or looking at a set of interdependent files. This is done by 
creating a virtual GoBack Drive, whose contents correspond to your 
real hard disk as it was at some time in the past. For example, if C: is 
your hard disk, then you might ask GoBack to create a virtual 
GoBack Drive corresponding to C: as it was an hour ago. The virtual 
GoBack Drive you create will automatically be assigned a drive 
letter (for example, D:). This drive D: is very much like a backup of 
your entire hard disk drive that was made an hour ago. You access 
drive D: in the same way you would your floppy disk A:. While you 
are maintaining a virtual GoBack Drive the system must spend a 
certain extra effort to keep the virtual drive up to date. Thus, when 
you are done using your virtual GoBack Drive (drive D: for 
example), you should ask GoBack to discard it.

Retrieve Specific Files from the Past
Deluxe Edition users may choose to retrieve specific files from the 
past. For those times when you don’t want to completely revert your 
hard disk just to get back one deleted or overwritten file, you can 
use the File Recovery Window or the GoBack shell extension in 
Windows Explorer. Here you can select from various versions of a 
file by name and date, and either restore it or just bring it back for 
quick viewing.
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Rescue Select Files After Doing a Revert
After completing the revert hard drive option and logging back into 
Windows, Deluxe Edition users are automatically presented with a 
screen that lets them rescue the files they want. This screen lets users 
rescue any files that were changed or deleted after the time to which 
they reverted the drive. Users have the final say on which changed 
or deleted files they may want to keep.

GoBack Scenarios
After you’ve started using GoBack regularly, you may come to 
wonder how you ever lived without it. There are so many instances 
where “Undo” doesn’t do it, and your tape backup wasn’t made an 
hour ago so it won’t help. The following examples illustrate how 
you can use GoBack to avoid wasted work, save time, and avoid 
aggravation.

■ At 7:20, you install some new software and then turn your 
computer off. You remember something you want to do so you 
turn your computer back on. But when you try to turn it back 
on, it does not boot at all! Use GoBack to revert your disk to 
7:20 and start over.

■ At 9:15, you started work on your big, monthly progress report 
using last month’s report as a template. At 9:50, you save your 
work, only to realize that you’ve just saved this month’s report 
over the only copy of last month’s report. Using the GoBack 
Deluxe Edition, create a GoBack Drive to go back to 9:15, 
retrieve last month’s report and save it somewhere else, and 
then return to 9:50 where you left off.

■ You downloaded something from the Internet and things just 
don’t look right. Sure enough, your virus checker found 
something. Let GoBack take you back to the time before the 
download.

GoBack Documentation and Help
GoBack uses standard Microsoft Windows operating system 
conventions. This document assumes you are familiar with these 
conventions. If not, please refer to the appropriate Microsoft 
documentation for more details.
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To access GoBack documentation or Help:

■ Click the Tutorial button on the GoBack Main Menu.

■ Click the Help button on the GoBack Main Menu.

■ From the Help menu, click What’s This? and then position the 
mouse pointer over the section of the screen for which you 
would like help.

■ View screen-specific help by selecting it from the Help menu, 
or by pressing F1.

■ To access an online copy of this User’s Guide, select View 
User’s Guide from a Help menu, or select View User’s Guide 
from the Main Menu Drop-Down menu located in the upper-
left corner of the GoBack Main Menu.

What this User’s Guide Contains and How it is 
Organized
This User’s Guide contains a variety of information to help you 
more easily find out how to run GoBack Personal Edition or Deluxe 
Edition. It describes how to install and operate GoBack, how to 
contact technical support, answers frequently asked questions, and 
more.

This User’s Guide is organized according to how the GoBack menu 
options are arranged. For example, the Deluxe Edition’s Main Menu 
displays the Recover Files button above the Revert Your Hard Drive 
button. Accordingly, Chapter 5, File Recovery Window, appears before 
Chapter 6, Drive Revert Window.

Lastly, note that this manual discusses two products—GoBack 
Personal Edition and GoBack Deluxe Edition. IMPORTANT: 
Remember that GoBack Deluxe Edition contains additional features 
not available in GoBack Personal Edition. This means a number of 
topics in this manual are devoted to describing features that are only 
available in the Deluxe Edition. To help Personal Edition users, 
topics describing features that are only available in the Deluxe 
Edition are marked “Deluxe Edition.” Personal Edition users can 
ignore these topics.
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Before You Run Setup
There are a few basic steps you should take upon receiving 
your software:

■ Verify that your computer system meets all of the system 
requirements.

■ Read all accompanying documentation and the README.TXT 
file on the GoBack CD-ROM.

Check the Hardware and System Requirements
In order to use either the GoBack Personal or Deluxe Edition, be sure 
that your computer meets the following requirements:

■ Intel Pentium or Pentium-compatible processor running at 166 
MHz or faster (single-processor systems only)

■ PC compatible running Windows 95, Windows 98, Windows 
Me, Windows NT 4.0 (Service Pack 4 or later recommended), 
or Windows 2000. (GoBack may be used with virtually any 
type of Windows-based system. However, it is not 
recommended that you use GoBack with Windows NT Server 
or Windows 2000 Server due to the large number of server-
based events that they generate.)

■ 64MB of RAM

■ GoBack typically requires ten percent of your total hard disk 
space (user selectable). If you have less than 20% of your hard 
disk space available, GoBack will only use half of the available 
space.

■ 256-color display with 800 x 600 display resolution capability

■ CD-ROM drive or equivalent from which to install GoBack 
(not required for a network installation)

■ Sound card for audio while viewing GoBack Movie and 
tutorial (optional)

■ Minimum of 200MB of free hard disk space available
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Installing GoBack
Before you install GoBack, be sure to read all of the following 
instructions.

Overview of Installation Options
When installing GoBack, you will be asked to choose between 
Easy Install and Custom Install. For information about the network 
install option, see To Install GoBack from a Network on page 2-5.

■ Easy Install (recommended for most users) will automatically 
allocate ten percent of each of your physical hard disks to 
GoBack. (GoBack uses this space to store history information 
used to revert your computer to an earlier time.) If you have 
multiple partitions (logical drives), GoBack will scan your hard 
disk, find the partition with the most unused space, and 
allocate ten percent of the total hard disk’s space to GoBack. If 
you choose Easy Install, GoBack will install only on hard disks 
that have sufficient disk space.

■ Custom Install lets you choose which hard disks you want 
GoBack to protect and the amount of space you want GoBack 
to use on each of them. If you have more than one hard disk 
then GoBack, through a series of prompts, lets you protect (or 
choose not to protect by selecting none) each disk 
independently of the others. If you have multiple partitions 
(logical drives) on a single hard disk you can specify on which 
partition GoBack uses space, but GoBack still protects data in 
all the partitions on the hard disk. Note that it is not possible to 
protect just one partition on a single hard disk even though 
you can specify from which partition GoBack uses space.

Note: If installing on a Windows NT or Windows 2000 
system, ensure that you are logged into that computer as 
an Administrator or a user with administrative privileges.
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Selecting the Amount of Disk Space to Allocate to GoBack
During the setup of GoBack Personal or Deluxe Edition, you can set 
the amount of hard disk space allocated to GoBack (using the 
Custom Install option). This space is used by GoBack to store history 
information that GoBack uses to revert your computer to an earlier 
time. On an Easy Install, by default, 10 percent of your hard disk is 
allocated to GoBack. However, you should consider increasing this 
allocation based on the size of your hard disk, the amount of hard 
disk activity you expect, and the frequency of any Auto-Reverts that 
you schedule.

To increase or decrease the amount of disk space allocated to 
GoBack (more or less than the default 10 percent), thereby increasing 
or decreasing the amount of history stored by GoBack, select the 
Custom Install option during installation.

If you plan to use Auto-Revert (Deluxe Edition), we recommend you 
allocate as much disk space as possible (1-2 GB, if available). This 
allows GoBack to save more history information, which can prevent 
situations where GoBack reverts your computer before the 
scheduled time due to the GoBack history becoming full (for more 
information, see How Auto-Revert Works on page 4-13). If the hard 
disk has multiple partitions (logical drives), you can select on which 
drive to store the GoBack history. For example, if the C: drive is 
mostly full, but the D: drive is mostly empty, store the history on the 
D: drive.

To avoid having to reinstall GoBack, allocate a larger portion of 
your hard disk (more than 10 percent) during the initial installation 
of GoBack if:

■ The computer has a relatively small hard drive (2 GB or less)

■ The typical usage involves intensive disk write operations.

■ You have a long period between Auto-Reverts (for example, 
weekly reverts)

Note: You can set the disk space allocation only at installation 
time. Therefore, if you want to adjust this setting later, you 
will need to uninstall and then reinstall GoBack.
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Installing a Multiple User License
Note that when you are installing a multiple user license, you can 
avoid having to insert the CD-ROM in each local CD-ROM drive by 
using the CD Key found on the multiple user license agreement. The 
CD Key for a single-user, found on the CD-ROM sleeve, requires 
you to insert the CD-ROM in the local drive for each installation. For 
more on this, see the next topic To Install GoBack from a Network.

To Install GoBack from a Network

You can install GoBack Personal or Deluxe Edition via a command 
line from a shared network location. To do this, copy your CD-ROM 
to a network location or share the CD-ROM. Then, from your remote 
computers, access the shared copy of the CD-ROM and run:

setup.exe /Q /KXX-XXXXX-XXXXX-XXXXX

Where the “Xs” represent the CD Key found on your multiple user 
license agreement. This runs a quiet version of setup, which requires 
no user intervention, and uses the Easy Install option (see Overview of 
Installation Options on page 2-3).

To Install GoBack from CD-ROM
Before installing any major software application, including GoBack, 
you should back up your system.

1 Close all open applications/programs including virus-
checking software and task bar applications.

Note:  To install GoBack over a network, you must use the 
multiple user license CD Key that is found on your 
multiple user license agreement.

Note: In Windows 95/98/Me, GoBack will not install on 
any hard disks that are running in MS-DOS Compatibility 
mode. For more information, see What is MS-DOS 
Compatibility mode? on page A-2.
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2 Insert the GoBack installation CD into the CD drive. Click 
Install to start the installation. 

If the GoBack screen doesn’t appear automatically, from the 
Start menu, select Settings, Control Panel and double-click the 
Add/Remove Programs icon. At the Add/Remove Programs 
Properties window, select the Install/Uninstall tab and click 
the Install button.

3 Review the End-User License Agreement and, if you agree to 
the terms, select Yes, then click Next to continue.

4 When the Readme screen displays, click Show README File 
to review it, or click Next to continue.

5 If Acrobat Reader is not installed on your system, you will 
either be given the opportunity to install it or you will be 
shown from where you can download it. Since Acrobat Reader 
is required to view the User’s Guide included on the GoBack 
CD-ROM, you should install it using whichever option is 
available. Otherwise, if Acrobat Reader is already installed on 
your system, proceed to the next step.

6 Type your name, company (optional), and CD Key (the 
CD Key is on the GoBack CD-ROM sleeve) and click Next.

7 Select Easy Install or Custom Install. Easy Install is 
recommended for most users. You can also specify where you 
would like the GoBack files installed.
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8 If you selected Custom Install in the previous step, the dialog 
box shown below displays. (Initially, this dialog box displays 
the settings that GoBack would have used had you selected the 
Easy Install option.)

Using this dialog box, modify GoBack’s space allocation for the 
hard disk. If the hard disk contains more than one partition, 
you can change the partition on which GoBack uses space. 
Use the space allocation field in the lower portion of the dialog 
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box to enter exactly how much disk space to allocate to 
GoBack.

If you have more than one hard disk, click Next and repeat the 
space allocation process for the other hard disks. If there is a 
particular hard disk on which you do not want GoBack 
installed, select none. After you have completed the space 
allocation process, click Next to continue with the installation.

9 The Setup Wizard then presents a summary of your chosen 
options. Click Finish to proceed with the installation.

GoBack allocates space to store GoBack history and copies 
GoBack program files.

10 Follow the on-screen instructions to complete the installation. 
You will need to restart your computer to enable GoBack.

Note: If you have multiple partitions (logical 
drives) on a single hard disk, you can specify from 
which partition you want GoBack to use space, 
but GoBack still protects data in all the partitions 
of the hard disk. It is not possible to protect just 
one partition on a single hard disk even though 
you can specify from which partition GoBack uses 
space.
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After Installation

After installation, please register GoBack to receive valuable 
benefits. (See The Drop-Down Menu on page 4-4.) Also, you will 
notice a few changes to your Windows desktop. An icon (shortcut) 
now displays on your desktop if you requested it during setup. 
There will also be a shortcut placed in the status area of the task bar 
(near the clock), from which you can access GoBack.

After installation, GoBack continually protects and monitors your 
hard disks without requiring any action on your part. With data 
GoBack has collected, you can:

■ (Deluxe Edition) View the past by creating a virtual GoBack 
Drive and use it like any other drive.

■ Bring the past forward by reverting your entire hard disk.

■ (Deluxe Edition) Recover files, including deleted and 
overwritten files.

To uninstall GoBack, use the Add/Remove Programs option in 
Windows Control Panel.

Starting GoBack
After GoBack is installed, it automatically runs whenever you start 
your computer (unless GoBack has been disabled). The GoBack 
Main Menu can be started one of several ways:

■ Click Start, then Programs, then GoBack.

■ Click the GoBack icon in the task bar.

■ Right-click the GoBack icon in the task bar, and then select 
Display GoBack Menu. (From the menu that displays, you may 
also select other main GoBack functions.)

Note: For Deluxe Edition users, we strongly recommend 
that you set GoBack Administrator and User passwords 
after installing GoBack. These passwords are independent 
of Windows NT and Windows 2000 passwords and are 
your only methods of protecting the GoBack drive revert 
and file recovery features from unauthorized use. For 
more information, see Passwords on page 4-7.
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■ Double-click the GoBack shortcut on the desktop (if available).

Once open, the GoBack Main Menu is the main interface into 
GoBack through which most of its services can be accessed. With 
GoBack Personal Edition, you can easily revert your hard disk to the 
way it was in the past. Or, with GoBack Deluxe Edition, you can 
create a virtual GoBack Drive, retrieve specific files, revert your hard 
disk and more.

The Deluxe Edition includes the GoBack shell extension into 
Windows Explorer, which provides a convenient way to access old 
versions of a specific file. Similar functionality is also available 
through the GoBack Deluxe Edition’s Main Menu.

The GoBack Boot Screen appears briefly before the operating system 
starts (when you turn on your computer). By pressing the spacebar 
you can access a limited, but sometimes very useful, set of functions 
that are normally accessed when you cannot boot into Windows.

Tutorials
The following tutorials will illustrate what GoBack can do and how 
to use it.

Reverting Your Hard Disk
In this tutorial, you are going to delete a number files from your 
computer and then revert your entire hard disk to the past to 
demonstrate that your hard drive can be restored to the way is was.

1 Restart your computer (click Start, Shut Down, then Restart). 
This step is present to simplify the example.

WARNING: To fully demonstrate the capabilities of GoBack 
you will be instructed to delete or modify existing files. You 
will then use GoBack to retrieve those deleted files or earlier
versions of files. If you want, you can make a backup of any 
files before deleting or modifying them.

WARNING: Before you begin, verify that GoBack is installed 
and that you can access the GoBack Main Menu (see Starting
GoBack on page 2-9).
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2 In Windows, using Windows Explorer, delete at least one file 
from a folder on your C: drive.

3 Empty your Recycle Bin (right-click Recycle Bin then click 
Empty Recycle Bin from the shortcut menu). Under normal 
circumstances, your files would now be gone.

4 Now you will use GoBack to revert the drive to a time that 
corresponds to when the files existed. For this tutorial you will 
do this from the GoBack Boot Menu. You can always access the 
GoBack Boot Menu—even if Windows does not start. To do 
this, restart your computer, press the reset button, or turn the 
power off and back on.

5 When the GoBack Boot Screen message appears, quickly press 
the spacebar. This will open the GoBack Boot Menu.

6 From the GoBack Boot Menu, click the button labeled Revert 
Drive (or press the letter “R”). GoBack will then suggest times 
in the past to which you can revert your hard disk. These times 
will be sometime before you deleted the files in Step 2.

7 Select the earliest time at which you knew the files existed, 
click Revert, and follow the on-screen instructions. GoBack 
will then proceed to restore your hard disk to the way it was at 
that specified time and reboot the computer.

8 This time, when the GoBack Boot Screen appears, do not press 
the spacebar. Let the computer boot as normal. After Windows 
starts, you can verify that the deleted files have been restored 
and the hard disk is back to the way it was.

9 If you want, you can repeat this procedure to revert to an 
earlier time. You can even revert to a time just before the last 
revert—essentially going back “to the future” again!

Note: After a drive reverts, GoBack Deluxe Edition lets users 
rescue files using a window that displays automatically. For 
more on this, see The File Rescue Window on page 7-2.
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Recovering an Overwritten File
Have you ever overwritten or deleted a document or other file and 
wanted to go back to the old version? You can do this easily with 
GoBack Deluxe Edition. In this tutorial you will modify a file, save it 
(overwriting the original), and then retrieve the original file.

1 Open one of your documents or other data files (any file in the 
My Documents folder should work).

2 Modify the document in some way. For example, if you 
opened a Microsoft Word document, you could delete some of 
the text or add some new text.

3 Save the file. This will replace the original with the new, 
modified version. Note that if a file is saved twice in quick 
succession (within about 10 seconds) there is a chance that 
GoBack will not be able to recover the interim revision. 
However, earlier or later versions are still recoverable. (GoBack 
requires that your computer’s disk be idle for a few seconds in 
order to identify “boundaries” between different versions of 
a file.)

4 Now close the program you used to edit the file. At this point, 
the old version of the file is lost and cannot be recovered by 
any conventional “undelete” utility.

5 In Windows Explorer, right-click the file you just modified 
then click Show Revisions from the shortcut menu. GoBack 
will display a list showing all the versions of the file that can be 
recovered. The first (top) entry is the current version, and the 
second one is the file that you overwrote.

6 Just to make sure, click the second file then click the Open 
button. This will open the old version of the file. If this is the 
old version, you can:

■ Close the program that started, click the Recover To button, 
and select a location in which to save the file.

- OR -

■ To replace the current version with the previous one, you 
can just click Save in the program. The original file is 
recovered, replacing the modified version.



2-13

Getting Started

Recovering Several Files at Once
In this GoBack Deluxe Edition tutorial, you will delete several files 
and recover them by creating a GoBack Drive—a virtual drive that 
shows your drive as it was in the past.

1 Delete some of the files in the My Documents folder. As with 
the other tutorials, if you want, you can make a backup copy of 
the files in the My Documents folder before you begin.

2 Empty the Recycle Bin (right-click Recycle Bin then click 
Empty Recycle Bin from the shortcut menu). At this point, the 
files you deleted are, for the most part, irretrievable.

3 Open the GoBack Main Menu (see Starting GoBack on 
page 2-9).

4 On the GoBack Main Menu, click the button labeled Advanced 
Features. The GoBack Drive Window displays.

5 If you have more than one hard disk, make sure the disk that 
contained the deleted files is selected in the File menu.

6 Near the end of the Event List (you may need to use the scroll 
bar on the right side to scroll to the end) you should see several 
entries in a row that show your files being moved to, and then 
deleted from, the Recycle Bin.

7 Above those entries, there should be a System Safe Point. Click 
to select that safe point. This is the point in time before you 
deleted the files and when GoBack considered the hard drive 
“safe.”

8 Click the Create GoBack Drive button at the bottom of the 
window. A GoBack Drive—a virtual drive—is created showing 
what your real hard drive looked like at the time you selected. 
When a GoBack Drive is created a message box appears, 
indicating what drive letter was assigned to it.

9 You can now use Windows Explorer to view the GoBack Drive. 
In Windows Explorer, open the My Documents folder on the 
GoBack Drive. The files you deleted previously should be 
visible there.
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10 To recover the files, drag them from the GoBack Drive to your 
real hard drive (you can also use Windows Explorer’s cut-and-
paste capability).

11 After you have recovered the files, you can return to the 
GoBack Drive Window and click the Discard GoBack Drive 
button to get rid of the GoBack Drive.
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The GoBack Boot Screen
You can perform four functions using the Boot Screen:

■ Revert your hard drive

■ Boot up from a floppy

■ Disable GoBack

■ (Deluxe Edition) Enable Auto-Revert

With GoBack installed, each time you start your computer the 
GoBack Boot Screen appears before the operating system screen 
displays. By sitting between your hard disk and the operating 
system, GoBack lets you, among other things, revert your hard disk 
back in time to undo catastrophic software failures and restore 
crashed systems.

The GoBack Boot Screen appears briefly during your computer’s 
start up. You are given several seconds to press the spacebar. Doing 
this lets you access the GoBack Boot Menu’s recovery functions. If 
you do not press the spacebar, the computer starts normally.
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If the operating system starts properly, access GoBack from 
Windows. However, if Windows will not start, the GoBack Boot 
Screen is there to revert your hard disk to a time when Windows 
would start. Even if the revert point (the time in the past to which 
GoBack reverts your hard disk) is not ideal, after you revert and 
then start Windows successfully, you can use GoBack in Windows to 
revert to a better time. 

WARNING: If it appears that your computer has a physical 
hardware failure then it should be serviced before you 
attempt any data recovery. Repeated attempts to recover 
using GoBack will use up your GoBack history and may 
reduce the possibility of reverting your hard disk after the 
physical problems have been repaired.

Note: The GoBack Boot Screen supports most mice. 
However, if the pointer for your mouse does not appear on 
screen, you will need to use the access keys (underlined 
letters) appearing in each command option. Press the 
underlined letter in order to select the option.
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Using the GoBack Boot Menu
The actions available in the GoBack Boot Menu are described below:

■ Revert Drive: Activates the GoBack emergency recovery 
option. Use this when your PC is unable to boot up normally. 
For more information, see Reverting Your Hard Disk on page 3-5.

■ Disable GoBack: You must disable GoBack if you are using an 
operating system not supported by GoBack and wish to view 
all files across all drives, or if you want to use disk-partitioning 
software. For more information, see Disabling GoBack on 
page 3-7.

■ Disable/Enable Auto-Revert: (Deluxe Edition) Lets you enable 
or disable Auto-Revert. It also indicates whether or not Auto-
Revert is enabled. For more information, see Enabling/Disabling 
Auto-Revert on page 3-7.

(Deluxe Edition) 

Note: If you are using the GoBack Deluxe Edition and 
you have passwords set, you will be prompted for a 
password before proceeding with password-protected 
GoBack features. For more information, see Passwords on 
page 4-7.
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■ Boot from Floppy: This option is necessary only if you want to 
boot and run an application from a diskette and have access to 
your GoBack-protected hard disk(s). For more information, see 
Booting from a Floppy Disk on page 3-8.

■ Continue: Select this option to proceed with the normal boot 
process of your system (from your hard disk).

Reverting Your Hard Disk
If your system fails to boot and you are unable to run Windows, use 
the GoBack Boot Menu to perform an emergency recovery—
reverting your hard disk back to a time when Windows was 
operating.

When you choose to revert from the GoBack Boot Screen, GoBack 
recommends revert times starting with recent safe points. Choose a 
point that corresponds to a time when your computer was working 
fine. If you are not successful the first time you revert, revert again 
and select a different time. Generally, the first one or two revert 
attempts will succeed in letting your computer’s operating system 
start again.

If GoBack is not able to revert to a time that allows you to properly 
start your computer, then you need to restore from your traditional 
backups. Keep in mind that a physical malfunction—like the 
microprocessor failing—will not be fixed by either GoBack or a 
traditional backup, however the data on your hard disk may not be 
lost either.

If you have more than one hard disk protected by GoBack, the revert 
will affect all these disks.

WARNING: If it appears that your computer has a physical 
hardware failure then it should be serviced before you 
attempt any data recovery. Repeated attempts to recover 
using GoBack will use up your GoBack history and may 
reduce the possibility of reverting your hard disk after the 
physical problems have been repaired.
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To revert your hard disk from the GoBack Boot Menu:

1 Restart your computer (use the power switch, the reset button, 
or press Ctrl+Alt+Delete).

2 When the GoBack Boot Screen appears, press the spacebar.

3 From the GoBack Boot Menu, click Revert Drive. GoBack will 
search your physical hard disk for safe times (when your hard 
disk was idle) to which to revert. GoBack identifies safe points 
and displays them in a dialog box (shown below). You can 
select a time and click Revert, click More Times to see 
information about other possible times, or click Cancel to 
cancel the revert request.

After you have selected a revert time, and pressed Revert, your 
system will restart and try to boot. (Remember, do not press 
the spacebar the second time through the boot process.)

4 If your computer still does not start correctly, repeat Steps 1 
through 3 and select a different time.

After your computer is able to start Windows, you can generally use 
the GoBack Drive Window to select a different time to which to 
revert your hard disk. The additional information provided in this 
window may be helpful in selecting a more desirable time. See 
Chapter 8 for more information.

Note: After you revert your hard disk using GoBack Deluxe 
Edition, the GoBack File Rescue Window displays. This 
window allows you to recover files changed after the time 
to which you reverted your hard disk. For more detail on 
this key function, see The File Rescue Window on page 7-2.
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Enabling/Disabling Auto-Revert
The Auto-Revert feature, which is only available with GoBack 
Deluxe Edition, is described in detail in Chapter 4, and can be 
enabled or disabled from the GoBack Boot Menu. See Auto-Revert on 
page 4-8.

Disabling GoBack
Occasionally, such as when you are going to use disk-partitioning 
software, you will want to disable GoBack. It is important to 
remember that whenever you disable GoBack, all the history that 
GoBack has been tracking will be lost. In other words, you will not 
be able to revert your disk or retrieve old versions of a file prior to 
the time you disable GoBack.

To disable GoBack from the GoBack Boot Menu:

1 When the GoBack Boot Screen appears, press the spacebar 
(you are given a few seconds). If you miss pressing the 
spacebar, restart your computer and try again.

2 Select the Disable GoBack button from the GoBack Boot 
Menu.

GoBack can also be disabled from the Options button in the GoBack 
Main Menu.

Note: If you are upgrading your operating system or 
installing operating system service packs, you must first 
uninstall GoBack (using Add/Remove Programs in 
Windows Control Panel). After you complete your 
operating system upgrade, you can re-install GoBack 
(assuming you upgraded to an operating system that 
GoBack supports).
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Enabling GoBack
If you have disabled GoBack, either through Windows or from the 
Boot Screen, each time you try to access GoBack in Windows (via the 
Start menu or the GoBack icon in the task bar), you will be reminded 
that GoBack is disabled. You will then have the option to enable 
GoBack. Since the GoBack Boot Screen only displays when GoBack 
is enabled, you can only enable GoBack from Windows.

Booting from a Floppy Disk
When installed and enabled, GoBack monitors all access to your 
hard disk automatically. For those programs that require you to start 
your computer with a special boot disk, the GoBack Boot Menu lets 
you boot from a floppy disk and still have the protection of GoBack. 
The following procedure describes how to do this. (If you do not use 
the following procedure, you can only boot from the floppy if the 
floppy’s program does not need to access the hard disk.)

To boot from a floppy disk:

1 Start the computer without the floppy disk in the drive.

2 When the GoBack Boot Screen appears, press the spacebar.
The GoBack Boot Menu appears.

3 Insert your program’s floppy disk in the floppy drive.

4 From the GoBack Boot Menu, select Boot from Floppy.
Your computer boots from the floppy.

Note: When booting from floppy, do not put the floppy disk 
in the floppy disk drive until after the GoBack Boot Menu 
displays. For more on this, see the following procedure.
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The GoBack Main Menu
From the GoBack Personal or Deluxe Edition Main Menu (both are 
shown below), you can access nearly all of GoBack’s capabilities.

To open the GoBack Main Menu, select GoBack from Programs in 
the Start menu, click the GoBack icon in the status area of the task 
bar, or double-click the shortcut on the Windows desktop.

GoBack Personal Edition

GoBack Deluxe Edition
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Main Menu Items
The options on the GoBack Main Menu’s left side are as follows:

■ Recover files: (Deluxe Edition) Click this button to display the 
File Recovery Window. This window allows you to recover 
deleted files, or retrieve an earlier version of a changed file.

■ Revert your hard drive: Click this button to display the Drive 
Revert Window. This window allows you to revert your hard 
drive to the way it was in the past.

■ Advanced features: (Deluxe Edition) Click this button to 
display the GoBack Drive Window. This window allows you to 
see your drive as it was in the past and choose an optimal 
revert time.

■ Tutorial: Click this button to display the Tutorial. The tutorial 
describes what GoBack can do and how to use it.

The options on the GoBack Main Menu’s right side are as follows:

■ Upgrade: (Personal Edition only) Click this button to upgrade 
to GoBack Deluxe Edition.

■ Update: Click this button to update your version of GoBack to 
the most current version.

■ Options: Click this button to open the GoBack Options dialog. 
See GoBack Options on page 4-5.

■ Help: Click this button to display the GoBack Help system.
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The Drop-Down Menu
Access the main menu drop down list by clicking the icon located in 
the upper-left corner of the GoBack Personal or Deluxe Edition Main 
Menu.

■ About GoBack: This option displays the version number of 
GoBack that is installed on your system. If you need technical 
assistance, it is important to have this number available when 
you call.

■ Icon in System Tray: Turns on (selected) or off the GoBack icon 
that displays in the task bar (near the clock).

■ Register your product: This option provides you with the 
opportunity to receive industry-leading technical support, 
product updates, and other news from Roxio.

■ View Users Guide: This option allows you to open this User’s 
Guide online.

■ Help: This option opens the GoBack Help system.

■ Exit: This option closes the GoBack Main Menu.
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GoBack Options
The GoBack Options dialog lets you modify settings in four areas: 
History, Internet, Passwords and Auto-Revert (Passwords and Auto-
Revert available only in GoBack Deluxe Edition). The GoBack 
Options dialog is accessible by clicking the Options button on the 
GoBack Main Menu.

History
In the History tab you can Clear GoBack History for selected drives 
or Disable GoBack.

■ Clear GoBack History: To prevent anyone from seeing your 
computer’s history, click Clear GoBack History. When you 
clear the GoBack History you also take away your ability to 
revert to the times you cleared. Once it has been cleared, 
GoBack History cannot be restored.
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■ Disable GoBack: Occasionally, such as when you are going to 
change or upgrade operating systems or if you want to use 
disk-partitioning software (FDISK for example), you will need 
to disable GoBack. It is important to remember that whenever 
you disable GoBack, all the history that GoBack has been 
tracking is lost. In other words, you will no longer be able to 
revert your disk or retrieve old versions of files.

To disable GoBack, click the Disable GoBack button. When 
you disable GoBack it also clears all the GoBack History.

Internet
The Internet tab contains options relating to the web update feature 
that lets GoBack automatically check the Internet for important 
updates. If your computer has an Internet connection, this option is 
enabled by default. The Periodically check... check box lets you turn 
this option on or off. To open the browser and view the latest 
update, click View Updates. Or, to go to the main Roxio web site, 
click Visit the Roxio web site.



4-7

GoBack Main Menu

Passwords

The Passwords tab, available only in GoBack Deluxe Edition, is 
where you can set two levels of password protection (Administrator 
and User) to secure access to GoBack services. Initially, these 
passwords are set to blank (no characters). Therefore, password 
protection is disabled by default.

To enable password protection, click Change Administrator 
Password or Change User Password. After you set passwords, 
users will be prompted to enter a password when they use certain 
GoBack services (as described on the following page). To 
discontinue password protection, set both passwords to blank 
(no characters) again.

 

Caution: Be sure to enable password protection by entering 
an Administrator password. This will prevent users from 
disabling any of your scheduled Auto-Reverts or setting a 
password themselves and locking you out!

!

Setting GoBack
Administrator password
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The table below lists GoBack services and options that can be 
protected with the GoBack Administrator and User passwords.

Auto-Revert
Available with the GoBack Deluxe Edition, Auto-Revert rolls back 
your hard disk at a pre-determined time automatically. Based on a 
schedule you determine (nightly, weekly, etc.) and/or at logoff or 
system shutdown, Auto-Revert automatically rolls back a 
computer’s hard disk to a pre-defined clean state without user 
intervention. It is an ideal solution for computer labs, libraries, and 
other public-access computer environments. 

The Auto-Revert tab of the GoBack Options dialog, lets you enable 
this feature, set the Auto-Revert schedule, and manually invoke an 
Auto-Revert. We recommend that you secure your Auto-Revert 

GoBack Service / Option Administrator User

Revert Drive X

Create / Discard GoBack Drive X X

File Open / File Recovery X X

Clear GoBack History X

Disable GoBack X

Update GoBack X

Disable / Enable Auto-Revert X

Change Auto-Revert Settings X

File Rescue X

Note: If you forget the GoBack Administrator password and 
need to reset it, you must uninstall and reinstall GoBack, 
thereby resetting all GoBack passwords to blank. If you 
forget the GoBack User password and want to reset it, you 
can enter the GoBack Administrator password in the 
Change GoBack User Password dialog and set a new 
password. If you forget your GoBack Administrator 
password while Auto-Revert (discussed below) is enabled, 
please call technical support.
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settings by enabling GoBack password protection as described in the 
previous section. This will prevent anyone except the GoBack 
administrator from disabling Auto-Revert or changing Auto-Revert 
options.

To enable Auto-Revert, click the Enable Auto-Revert check box. 
(Auto-Revert can also be enabled from the GoBack Boot Menu. To 
see how to do this, refer to page 3-7.) Upon enabling Auto-Revert 
and clicking Apply or OK, you are prompted to reboot the 
computer. The auto-revert point is always set to the time of the 
reboot that happens immediately after enabling Auto-Revert.

 

Caution: When an Auto-Revert occurs, the GoBack History 
is cleared. This means that you will not be able to roll back 
to any time before or since the Auto-Revert point. After the 
Auto-Revert, GoBack starts building new history 
information.

!

Note: If you have set an Administrator password in the 
Passwords tab, you will be prompted to enter it whenever 
you make changes and click the Apply or OK button.
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To manually revert to the Auto-Revert point, click the Auto-Revert 
Now button on the Auto-Revert options tab or on the GoBack 
Boot Menu.

Scheduling Auto-Revert

There are three ways you can schedule or define when to 
Auto-Revert:

■ On logoff or Shutdown / Restart

■ Set a time to auto-revert every day

■ Set GoBack to read the schedule from a file (useful in setting 
multiple Auto-Revert times or using a shared schedule file on a 
network)

You can use any combination of scheduling options.

Caution: While Auto-Revert is enabled, you cannot 
uninstall, reinstall, upgrade or update GoBack. To retain 
your Auto-Revert point, click Auto-Revert Now to roll 
back the PC, then disable Auto-Revert, and proceed with 
the uninstall, reinstall, upgrade or update. If you forget 
your GoBack Administrator password while Auto-Revert 
is enabled, please call technical support.

!
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If you are using GoBack Deluxe Edition in a computer lab or other 
networked environment, it can be useful to select the Auto-Revert 
on Log Off or Shutdown/Restart option. This option ensures that 
the next computer user (assuming the last user logged off properly) 
has a clean slate on which to begin their work. Or, if a time-based 
Auto-Revert is preferred, select the Read Auto-Revert schedule 
from file option and have all the computers read the schedule from 
a single file (preferably on a server) that contains the Auto-Revert 
schedule. This way, if you decide to change the schedule, you only 
have to make the change once and all of the computers can be 
updated automatically with the new schedule. The computers must 
be logged into the network to access the schedule file.

To use the Read Auto-Revert schedule from file option, you must 
first create a text file containing the time and day information of 
when you want the Auto-Revert to happen. You should schedule the 
Auto-Revert to take place at a time that corresponds to when no one 
will be using the computer. If the computers are turned off at night 
you may want to choose an Auto-Revert time that corresponds to a 
time right after the computers are turned on, or before the 
computers are turned off each day.

Note: If a scheduling option is not selected, the Auto-Revert 
happens only when the GoBack History becomes 100% full 
or you click the Auto-Revert Now button in the 
Auto-Revert options tab. 

Note: If messages begin to display stating that the GoBack 
History is getting full, you can eliminate this problem by 
increasing the GoBack History buffer’s size. To do this, 
uninstall then reinstall GoBack, select Custom Install, then 
allocate more hard disk space to GoBack. Note that your 
current history is discarded during the uninstall process.

Caution: Do not schedule an Auto-Revert for a time when 
the computer is powered off. When the computer is off, 
GoBack cannot detect and perform an Auto-Revert.

!
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For highest security, your schedule file should reside on a network—
GoBack cannot protect a user from accessing this file on a local 
drive. To ensure that GoBack can use your schedule file, the network 
location of the file should be publicly read-accessible at startup and 
cannot be a Windows-mapped drive.

GoBack requires that your schedule file have one line per 
Auto-Revert time and that each entry on a line be separated by a 
space. Each line should have a time of day followed by days of the 
week (acceptable English-only syntax and abbreviations are shown 
below). Also, the schedule file must be in the hour:minute, English-
only format for the file to work properly with the Auto-Revert. Your 
schedule file can be saved using any file name.

10:30 Monday Wednesday Friday
15:00 sunday tuesday thursday saturday
3:00am Sun Mon Tue Wed Thu Fri Sat
8:00pm SU M TU W TH F SA

Note: If you do not specify a.m. or p.m., the time will be 
interpreted in a 24-hour format (for example, 3:00 = 3:00 
a.m.; 15:00 = 3:00 p.m.).
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How Auto-Revert Works
When Auto-Revert is enabled, the computer rolls back automatically 
when one of the following events happens:

■ Upon a user logging off or shutting down Windows (if the 
Auto-Revert on Log Off or Shutdown/Restart option was 
selected).

■ When a scheduled Auto-Revert time is reached (if an 
Auto-Revert time was scheduled).

If a scheduled Auto-Revert time is reached, a sixty-second 
countdown appears on the screen (below). When this 
countdown reaches zero, the computer reboots and rolls back 
to the Auto-Revert point.

■ When the GoBack History is 100% full.

To protect your clean state, GoBack monitors its history and 
warns you when is at 50%, 75%, 85%, 90%, 95%, and 97% full. 
When the history becomes 100% full, the computer reboots and 
rolls back to the Auto-Revert point. You cannot cancel an Auto-
Revert when the history becomes full.

Note: If you are finding that your history is filling before 
your scheduled Auto-Revert, extend the amount of hard 
disk space allocated to GoBack. To do this, reinstall 
GoBack, select Custom Install, and increase the disk space 
allocated to GoBack. For more information, see Selecting the 
Amount of Disk Space to Allocate to GoBack on page 2-4.
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From any GoBack Auto-Revert warning dialog, you can cancel a 
scheduled Auto-Revert time by clicking Cancel (no password 
required). You can also click Disable Auto-Revert to completely 
disable it. If an Administrator password is set, you are required to 
enter the Administrator password before continuing.

To protect your Auto-Revert point, GoBack does not allow you to 
cancel when the history becomes 100% full.

Setting a New Clean State for Auto-Revert
Occasionally it will be necessary to change to a clean state—to add a 
new application, for example. With GoBack Deluxe Edition, this is 
easy.

1 Make sure the computer is at the clean state by initiating a 
manual Auto-Revert. To do this, open the GoBack Main Menu 
then click the Options button. In the GoBack Options dialog 
box, click the Auto-Revert tab then click Auto-Revert Now.

2 Now that the computer is clean, disable Auto-Revert by 
unchecking the Enable Auto-Revert check box. When 
disabling Auto-Revert, a reboot of the computer is not 
necessary.

3 You can now install the new application or make any 
modifications to the computer to create a new clean state.

4 Re-enable Auto-Revert. This will set your clean state.

Caution: When you disable Auto-Revert, the Auto-Revert 
point is discarded. If Auto-Revert is re-enabled, the 
Auto-Revert point is reset to the time at which it was 
enabled.

!

Note: Disabling Auto-Revert does not stop GoBack from 
protecting your hard disk.
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The File Recovery Window
With the File Recovery Window available in the GoBack Deluxe 
Edition, you can recover earlier versions of files, including files that 
have been overwritten or deleted. The File Recovery Window lets 
you select the file you wish to recover and the folder location in 
which to save the recovered file. Alternatively, you may directly 
open a file from the past. This causes the file to automatically be 
restored and the appropriate application launched to view it. In this 
case, the recovered file is stored in a temporary folder and is write-
protected, anticipating that you will save it elsewhere if you wish to 
keep it. These files are automatically discarded on system 
shutdown. Thus, while viewing a file directly opened from the past, 
if you wish to save it, you should do so promptly.

To open the File Recovery Window, click the Recover Files button 
on the GoBack Main Menu.

Selecting a Drive
When you have more than one logical drive, you must select the 
logical drive on which your file is located.

The File Recovery Window will initially show the first drive on your 
computer. If you wish to view a different drive, select it using the 
File menu.
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Working with the File List
The File List contains all the files that GoBack can recover. If you 
know what you are looking for, you can sort the list by clicking on 
any of the column headings.

The column headings include:

■ Name: The names in this column are the original names of files 
that GoBack can recover.

■ Size, Type: These columns help you identify the different 
versions of the files.

■ Location: This shows where each file was originally saved.

■ Original Time: This is the time that each file was originally 
created.

■ Modified Time: This is the last time that each file was 
modified, and corresponds to when they were added to 
the list.
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Sorting the File List
Initially the list is sorted in reverse order by Modified Time, with 
most recent versions at the top. You can click on each of the column 
headers to sort the list according to that column. By clicking on the 
column heading a second time, you can switch between ascending 
and descending order. File list sorting is automatically reset when 
you select Refresh from the File menu.

It is possible that some dates are initially out of order in the list. This 
occurs when an application modifies a file and then sets the 
modified date back.

Locating Files
To locate a file, type all or part of the file name into the Locate Files 
Matching text box then click Locate Now. This changes the file list to 
show only files with names that contain the text that you entered. To 
again view the complete list, click Locate All.

Selecting Files
After you select a file, you can either restore the file or directly open 
it. You cannot restore multiple files in one operation. In this situation 
you should consider creating a GoBack Drive that reflects the disk at 
some point in the past and then use Windows Explorer to copy files 
across to your main disk. This process is faster for recovering large 
numbers of files.

The Drop-Down Menus
Each GoBack window has several drop-down menus. These menus 
often list command button names that you can use instead of 
selecting the option you need from the drop-down menu.
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The File Menu

■ (C:): This option lets you change the selected drive. On your 
computer, drive labels may be different than the one shown in 
this illustration. To view files on a different drive, click the 
letter of the drive for which you want to recover files. In the 
illustration above, the C: drive is selected.

■ Open: The Open option on the File menu lets you open a 
selected file that displays in the File Recovery Window’s 
Changed Files list. Using this option, you can only open the file if 
the application with which the file was created is installed on your 
system.

Typically, you would open a file to decide whether you want to 
recover it. If you decide to recover the file, choose Save As 
from the File menu that displays and save the file to a desired 
location.

■ Recover Selected File To: This option lets you recover and 
specify a place to save a selected file. By default, the file is 
saved to its original location. You may want to choose an 
alternate location to avoid overwriting the current version of 
the file.

■ Refresh: Select this option to update the list of recoverable 
files, reflecting any changes since you opened the window. In 
other words, after you open the window, the list remains fixed. 
Continued system activity may make the list somewhat 
obsolete and therefore you may need to refresh it. 

■ Exit: This option closes the File Recovery Window.
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The Edit Menu

■ Find File: This option displays a standard Find dialog where 
you can enter all or a portion of the name of the file you are 
looking for. If a match is found, the file list will scroll to the first 
occurrence.

■ Find Next: This option repeats the previous find request 
starting from the current location in the list.

The Internet Menu

■ Update GoBack: This option allows you to receive GoBack 
version updates using the Internet. To do this, simply select the 
menu option. If you have Internet access, the Update GoBack 
option launches your web browser, and takes you to the Roxio 
web site. Follow the prompts to find if there are any GoBack 
updates available.

■ Upgrade GoBack: Only available with the GoBack Personal 
Edition, the Upgrade GoBack option provides users with the 
opportunity to upgrade from GoBack Personal Edition to 
GoBack Deluxe Edition. GoBack Deluxe Edition expands the 
overall usefulness of GoBack through the addition of key 
features and valuable benefits. For more about these features, 
see What GoBack Can Do for You on page 1-4.

■ Register GoBack: This option provides you with the 
opportunity to receive industry-leading technical support, 
product updates, and other news from Roxio.
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The Help Menu

■ Contents: This option opens the GoBack Help system.

■ GoBack File Recover Help: This option displays the GoBack 
Help system topic that is for the File Recovery Window.

■ What’s This: This option displays a screen tip for a command 
button or a screen region element. To use this function, click 
What’s This (or press Shift-F1) and then click the element 
about which you want information.

■ View User’s Guide: This option allows you to open this 
manual online.

■ About GoBack: This option displays the version number of 
GoBack that is installed on your system. If you need technical 
assistance, it is important to have this number available when 
you call.

The Command Buttons
The command buttons display at the bottom of the File Recovery 
Window and are described below.

■ GoBack Menu: Displays the GoBack Main Menu.

■ Open: With a file selected, click Open to view it. This is 
equivalent to the Open option in the File menu.

■ Recover To: Click this button to recover the selected file. This is 
equivalent to the Recover Selected File To option in the File 
menu.
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The Drive Revert Window
Available in both the Personal and Deluxe Edition, the Drive Revert 
Window displays an easy-to-use list of event times to which you can 
choose to revert your hard disk. Displaying just three key event 
types, the Drive Revert Window provides one of GoBack’s most 
powerful functions in a very simple, uncomplicated window.

The main function of the Drive Revert Window—Drive Revert—is 
also a part of the GoBack Drive Window, which is found in the 
Deluxe Edition. In contrast to how the GoBack Drive Window 
functions, there is no need to select a drive using the Drive Revert 
Window because it reverts all your system’s drives to the selected 
time. In the Deluxe Edition, the GoBack Drive Window expands the 
overall usefulness of Drive Revert with additional key functions. For 
more on these, see The GoBack Drive Window on page 8-3.

To open the Drive Revert Window, click the Revert Your Hard Drive 
button on the GoBack Main Menu.

The main elements of the Drive Revert Window are noted below:
Drop-Down Menus

Event List

System Safe Point Events

Start of System Boot Events

Command Buttons

Application Install Event
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Using Drive Revert
To use Drive Revert, complete the following steps:

1 Open the Drive Revert Window.

To open the Drive Revert Window, click the Revert Your Hard 
Drive button on the GoBack Main Menu.

2 Select a time.

You may select to revert to any one of the following three types 
of event-related times that display in the Event List:

■ System Safe Point: This event, which is marked by a green 
arrow icon in the Event List, refers to a point in time when 
there was no system activity.

■ Start of System Boot: This event, which is marked by the 
GoBack logo in the Event List, refers to GoBack activity such 
as system boots and disk reverts.

■ Application Install: This event, which is marked by 
Windows Setup icon in the Event List, refers to when an 
application was installed on your computer.

Simply click an event-related time to select it.

3 Revert your drives.

To revert your drives, click the Revert Now button. GoBack 
reverts your drives back to the way they were just before the 
event you selected.

After a drive reverts, GoBack Deluxe Edition lets users rescue files 
using a window that displays automatically. For more on this, see 
The File Rescue Window on page 7-2.
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The Drop-Down Menus
Each GoBack window has several drop-down menus. These menus 
often list command button names that you can use instead of 
selecting the option you need from the drop-down menu.

The File Menu

■ Revert System: This option reverts your system. It performs 
the same function as the Revert Now... button on the bottom 
right-hand side of the Drive Revert Window.

■ Exit: This option closes the Drive Revert Window.

The Internet Menu

■ Update GoBack: This option allows you to receive GoBack 
version updates using the Internet. To do this, simply select the 
menu option. If you have Internet access, the Update GoBack 
option launches your web browser, and takes you to the Roxio 
web site. Follow the prompts to find if there are any GoBack 
updates available.

■ Upgrade GoBack: Only available with the GoBack Personal 
Edition, the Upgrade GoBack option provides users with the 
opportunity to upgrade from GoBack Personal Edition to 
GoBack Deluxe Edition. GoBack Deluxe Edition expands the 
overall usefulness of GoBack through the addition of key 
features and valuable benefits. For more about these features, 
see What GoBack Can Do for You on page 1-4.
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■ Register GoBack: This option provides you with the 
opportunity to receive industry-leading technical support, 
product updates, and other news from Roxio.

The Help Menu

■ Contents: This option opens the GoBack Help system.

■ GoBack Revert Help: This option displays the GoBack Help 
system topic that is for the Drive Revert Window.

■ What’s This: This option displays a screen tip for a command 
button or a screen region element. To use this function, click 
What’s This (or press Shift-F1) and then click the element 
about which you want information.

■ View User’s Guide: This option allows you to open this 
manual online.

■ About GoBack: This option displays the version number of 
GoBack that is installed on your system. If you need technical 
assistance, it is important to have this number available when 
you call.

The Command Buttons
■ GoBack Menu: Displays the GoBack Main Menu.

■ Revert Now: Click this button when you are ready to revert 
your hard disk back to the way it was before a selected time. 
Note that a time must be selected in the Event List to make the 
Revert Now button active.
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The File Rescue Window
After completing the revert hard drive option and logging back into 
Windows, Deluxe Edition users are automatically presented with 
the File Rescue Window. This window lets you open, review, and 
rescue any files that were changed or deleted after the time to which 
you reverted your hard disk.

Check Box Files to be rescuedDrop-Down Menus

Command Buttons
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Using File Rescue
File Rescue is easy to use. Simply perform the following steps:

1 Revert your hard disk, and restart Windows.

When Windows restarts, the File Rescue Window displays 
automatically if a revert has occurred in the last hour. In 
addition, the File Rescue Window displays all files modified or 
lost due to any reverts that were done over the last 24 hours.

For example, suppose you reverted your hard disk at 9 a.m. 
and the File Rescue Window displayed 20 files. If you 
continued working and reverted your hard disk at 4 p.m. that 
same day, when Windows restarted, File Rescue would display 
the 20 files from the first revert and any files that you changed 
or deleted after the first revert. So after the second revert, in 
this example, File Rescue would display 30 files. Thus, File 
Rescue gives you a second chance to rescue any of the 20 files 
from the first revert and the normal option to rescue any of the 
10 additional files from the second revert.

2 Choose a file to rescue.

From the list of files that displays in the File Rescue Window, 
you have two options.

■ (Option 1) Click the Check Box in front of a file and then 
click the Open button. When the file opens, decide whether 
it is a file you want to rescue. If you want to rescue the file, 
choose Save As from the File menu that displays and save 
the file to a desired location. If it is not the file you want to 
rescue, simply close the file.

■ (Option 2) Click the Check Box in front of a file and then 
click the Rescue Files button. The file, or files, you selected 
is rescued and saved automatically to the location where it 
was originally saved! (Option 2 assumes that you know you 
want to rescue the file.)
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The Drop-Down Menus
Each GoBack window has several drop-down menus. These menus 
often list command button names that you can use instead of 
selecting the option you need from the drop-down menu.

The File Menu

■ Drive: This option lets you select the drive from which you 
want to rescue files. If you have one or more logical or physical 
drives on your system that are protected by GoBack, you can 
select them using this option.

■ Open: This option lets you open checked files that display in 
the File Rescue Window’s Changed Files list. Using this option, 
you can only open the file if the application with which the file was 
created is installed on your system.

Typically, you would open a file to decide whether you want it 
rescued. If you decide to rescue the file, choose Save As from 
the File menu to display and save the file to a desired location.

■ Rescue Files: This option lets you copy any checked files 
displayed in the File Rescue Window’s Changed Files list. 
When you choose this option, File Rescue automatically copies 
the checked files to the location where they were originally 
saved.

■ Exit: This option closes the File Rescue Window.
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The Help Menu

■ Contents: This option opens the GoBack Help system.

■ GoBack File Rescue Help: This option displays the GoBack 
Help system topic that is for the File Rescue Window.

■ What’s This: This option displays a screen tip for a command 
button or a screen region element. To use this function, click 
What’s This (or press Shift-F1) and then click the element 
about which you want information.

■ View User’s Guide: This option allows you to open this User’s 
Guide online.

■ About GoBack: This option displays the version number of 
GoBack that is installed on your system. If you need technical 
assistance, it is important to have this number available when 
you call.
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The Command Buttons
■ GoBack Menu: Displays the GoBack Main Menu.

■ Open: Click this button to open checked files that display in 
the File Rescue Window’s Changed Files list. Using this button, 
you can only open the file if the application with which the file was 
created is installed on your system.

Typically, you would open a file to decide whether you want it 
rescued. If you decide to rescue the file, choose Save As from 
the File menu to display and save the file to a desired location.

■ Rescue Files: Click this button to copy to your hard disk any 
checked files displayed in the File Rescue Window’s Changed 
Files list. When you click this button, File Rescue automatically 
copies the checked files to the location where they were 
originally saved.
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What is a GoBack Drive?
A feature available in the Deluxe Edition, a GoBack Drive is a virtual 
copy of your hard disk as it appeared at a selected point in the past. 
Such a drive lets you view or retrieve past (deleted or modified) 
versions of files or documents. The virtual GoBack Drive is 
constructed from information collected by GoBack while monitoring 
hard disk activity.

When you create a virtual GoBack Drive, GoBack creates a copy of 
your hard disk from a time that you selected in the past. GoBack 
automatically discards virtual drives when the historical data on 
which a drive is based becomes unavailable. This situation occurs 
when you continue to use your hard drive while at the same time 
maintaining a virtual drive. After you have created a virtual GoBack 
Drive and retrieved the desired files, it is best to discard the GoBack 
Drive. Should a GoBack Drive be automatically discarded and you 
attempt to access it, a “blue screen” error message may display. This 
is not a significant problem. To remove the blue screen, follow the 
on-screen prompts, or press any key.

If you do not plan to discard your virtual GoBack Drive right away, 
you can get an idea for how long you will be able to view the 
contents of the virtual drive. Compare the time the virtual drive was 
created with the bolded dates in the calendar. For example, if 
GoBack can see one week and you create a virtual GoBack Drive 
showing how the hard disk was one day ago, it is unlikely that this 
drive would be discarded in the near future automatically. On the 
other hand, if you create a virtual GoBack Drive showing how the 
hard disk was near the end of GoBack’s reach (in this example, one 
week), you could lose your virtual GoBack Drive at any time. In this 
situation, you should immediately recover any desired files from the 
virtual GoBack Drive.
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The GoBack Drive Window
To open the GoBack Drive Window, click the Advanced Features 
button on the GoBack Deluxe Edition Main Menu.

The GoBack Drive Window lets you retrieve data or system 
information from the past and bring it forward to the present two 
different ways. First, the GoBack Drive Window lets you select an 
event time to which you can revert your hard disk. Second, the 
GoBack Drive Window lets you create a GoBack Drive that is a 
virtual copy of your hard disk as it appeared at a selected time in the 
past.

The main elements of the GoBack Drive Window are noted below:

Clock

Calendar Event List
System
Safe Point

GoBack
Event

System
Activity

Process
Start Event

Command Buttons

System Boot



8-4

GoBack Personal and Deluxe Edition User’s Guide

GoBack Drive Window Colors
The colors that display in the GoBack Drive Window help users by 
adding contrast to the display.

Typically system safe points, which are enabled items to which you 
may revert, display in black. Other system events, which are 
disabled items to which you may not revert, display in gray. Note 
however, that your computer’s control panel, display appearance 
settings, can be used to change these base colors.

Other colors on the GoBack Drive Window, such as blue and green, 
are there as noted above to add contrast to the display.

Selecting What to View
As you are looking at the GoBack Drive Window, you can view your 
hard disk’s activities over the past several days. The bold numbers 
on the calendar indicate the days that you can view. The Event List 
shows you various events that occurred on your computer for the 
selected day. Use the calendar to view different days in the Event 
List. You can also filter the Event List so that you only see the types 
of activities that are of interest to you.

You may select events directly from this list by clicking the desired 
item. The clock automatically remains synchronized with the 
highlighted selection in the Event List. The clock can be used to 
position the Event List to a specific point in time. Type a specific 
time in the area beneath the clock and press the Enter key. 
Remember to indicate a.m. or p.m. The Event List will be updated to 
show the events closest to the time you selected.

You may view or revert your hard disk to a point in time that 
corresponds to a Safe Point or system Boot event in the list. Safe 
Points are automatically created whenever your computer is idle for 
several seconds. As selectable points in time, safe points prevent you 
from accidentally choosing a time that is right in the middle of disk 
activity (for example, saving a word processing document). 
Accessing such points in time would typically yield useless 
transitional data, so GoBack avoids these points.
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Selecting a Drive
The GoBack Drive Window will initially show the first physical hard 
disk on your computer. To view a different disk, select it from the 
File menu.

Selecting the Date
Dates for which you can view events appear in bold on the calendar. 
Clicking on a date will cause the Event List to update with the 
activity for that date. The date being viewed is highlighted on the 
calendar. You can click the left and right arrows to scroll to the 
previous and next month in which there are events available to view.

Selecting the Time
The clock in the GoBack Drive Window provides another way to 
make a selection from the Event List. When you type a time into the 
space under the clock and press Enter, it will select the safe point 
event from the Event List that is closest to the time you entered. You 
can also select a time by moving the hands of the clock with your 
mouse.

Working with the Event List
The Event List (shown below) is the primary feature of the GoBack 
Drive Window. It lets you review your system activity to help you 
find useful times to which to view or revert your hard disk. For 
example, it might show you when you launched programs or 
modified files. You can scroll through the Event List to view the 
logged events for the currently selected day. If you have more than 
one physical drive, you can view any other drive(s) and their 
partitions by selecting the desired drive letter from the File menu.

It may be helpful to filter the events (from the View menu) shown in 
the listing. You can also search for particular events by using the 
Find File or Note option in the Edit menu.
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There are several event types in the list, identified by the 
following icons:

Icon Description

The GoBack logo marks GoBack activity, such as 
system boots and disk reverts.

A Safe Point icon indicates a point in time when 
there was not any system activity.

This icon identifies events relating to system 
activity such as Windows startup and shutdown 
points.

This icon identifies activities related to files (such as 
documents, spreadsheets, etc.). There are numerous 
types of file activity, such as create, rename, and 
delete. If the name of a file is changed, both the old 
and the new names will be shown.
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Filtering the Event List
The Filters feature in the View menu filters out of the Event List files 
or folders of the types that you specify. GoBack continues to track 
filtered file or folder types, however. Note that filtering has no effect 
on the collection of information or your ability to recover it. It just 
modifies what you see when you view the Event List. The default 
filter list excludes Windows folder activity and .bak and .tmp file 
types. Note that when a folder appears in the File Filters list, all 
subfolders that are within that folder are also filtered.

■ Use Filters: Click to toggle filtering on and off. A check 
indicates that filtering is active and events may be omitted 
from the Event List.

■ Edit Filters: Select this option to specify the file extensions 
and/or folders you want to omit from the Event List.

Icon Description

This icon identifies user events, such as user added 
notes.

This icon designates shell execute events such as 
files opened or printed from Windows Explorer, or 
programs or files run from the Start/Run dialog.
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You can add items to both folder and file extension filters. Be sure 
you understand that although you are selecting Add, the effect is to 
remove the items from view. In other words, you are adding to the 
list items that you do not want to view.

You may want to filter out file extensions or folders that are not used 
for recovery purposes. For example you may want to filter out your 
temporary Internet files, or files with the extensions .dll, .exe, .hlp, 
.gid, .dat, .ffa, .ffl, and .ffv. Folders not needed for viewing might also 
be ~MSSETUP or Recycle. Filtering these out of the Event List can 
make it easier to find a specific item you want to recover.

To add an item to the filter list:

1 Click Add in the File Filters dialog box (the upper block 
displays folders; the lower block displays file extensions). A 
dialog box displays that lets you enter the specific folder or file 
type you wish to filter from view.

2 When you have entered the folder or file type to filter out, 
click OK.

To edit an item in the filter list:

1 In the File Filters dialog box, select the folder or file type you 
wish to edit.

2 Click the Edit button to the right of your selection. A screen 
will appear to let you edit the selected item.

3 After you have made your changes, click OK.

To delete an item from the filter list:

1 In the File Filters dialog box, select the folder or file type you 
wish to delete from the filter list.

2 Click the Delete button to the right of your selection.

You can also edit filters by right-clicking on a file event in the 
GoBack Drive Window and selecting Hide Events in this Folder or 
Hide Events of this File Type from the shortcut menu. The events 
you have hidden in this manner can be changed using the File 
Filters dialog box.
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Selecting Events
You can click to select any event in the Event List. However, if you 
intend to create a GoBack Drive or revert your disk you must select a 
safe point event. If you find a file event, such as a file modification, 
there are typically two safe points you can select. The safe point 
event that appears just after the file event corresponds to a point in 
time after the modification. Similarly, the safe point that appears 
prior to the file event corresponds to a time before the file was 
changed.

Finding a File or Note
To look for a specific file or note, choose the Find File or Note option 
from the Edit menu or press Ctrl+F. This option is used to perform a 
text search of file events and note entries in the Event List. Enter any 
part of the file name, folder, or extension or a portion of the note. 
The search is limited to the currently selected day. Select whether 
you wish to search down or up relative to the current position in the 
Event List. By default, the search direction is down. Searches are 
subject to filtering.

The Drop-Down Menus
Each GoBack window has several drop-down menus. Many of these 
functions are available using the command buttons or by clicking 
with the right mouse button while the pointer is on the appropriate 
part of the view.

The File Menu
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■ Drive C:, D:, E: and F: (If your computer has different hard 
drive letters, your File menu may appear different than 
pictured here.) A list of your physical disks is at the top of the 
menu—indicated by the logical drive letters assigned to it. (See 
Glossary on page B-1 for definitions of logical and physical 
disks). Click on a physical disk to view its Event List. If you 
only have one physical disk, no other selection is possible.

■ Create GoBack Drive at Selected Event: Creates a GoBack 
Drive based on the time you have selected in the GoBack Drive 
Window using the calendar and either the clock or Event List.

■ Discard GoBack Drive: After you are done with a GoBack 
Drive, you should discard it by selecting this option. You will 
see an on-screen message indicating that the GoBack Drive has 
been discarded and that the information is no longer accessible 
(without creating a new GoBack Drive). If multiple GoBack 
Drives were created because your physical disk consists of 
more than one logical drive, then all the GoBack Drives are 
discarded.

■ Revert Drive C: to Selected Event: Reverts your hard disk to 
the way it was in the past, based on the time you selected in the 
calendar and the Event List or clock. Select this option to revert 
all the drives on the selected physical disk to the way they 
were at the selected time. You must select a Safe Point or 
GoBack event for the revert.

■ Exit: This option closes the GoBack Drive Window.

Note: After you revert your hard disk using GoBack 
Deluxe Edition, the GoBack File Rescue Window 
displays. This window allows you to recover files 
changed after the time to which you reverted your hard 
disk. For more detail on this key function, see The File 
Rescue Window on page 7-2.
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The Edit Menu

■ Add Note to Log: This feature lets you add a note of your own 
to the Event List. For example, if you are going to install an 
application or work on important documents, marking the list 
prior to these activities can make earlier events easier to find. 
The note is added to the bottom of the list, like any new event. 
Adding a note does not constitute a selectable safe point (that 
is, you cannot necessarily go back to exactly the time at which 
the note was added).

■ Find File or Note: This option is used to perform a text search 
in the Event List and is described in the previous section on 
Finding a File or Note. 

■ Find Next: This will continue the previous search to the next 
match.

The View Menu

■ Use Filters: Click this option to toggle it on and off. When the 
check mark is visible, the filters are ON. For more information 
about filters, see Filtering the Event List on page 8-7.

■ Edit Filters: Select this option to specify the file extensions 
and/or folders you want to omit from the Event List.
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Internet

■ Update GoBack: This option allows you to receive GoBack 
version updates using the Internet. To do this, simply select the 
menu option. If you have Internet access, the Update GoBack 
option launches your web browser, and takes you to the Roxio 
web site. Follow the prompts to find if there are any GoBack 
updates available.

■ Upgrade GoBack: Only available with the GoBack Personal 
Edition, the Upgrade GoBack option provides users with the 
opportunity to upgrade from GoBack Personal Edition to 
GoBack Deluxe Edition. GoBack Deluxe Edition expands the 
overall usefulness of GoBack through the addition of key 
features and valuable benefits. For more about these features, 
see What GoBack Can Do for You on page 1-4.

■ Register GoBack: This option provides you with the 
opportunity to receive industry-leading technical support, 
product updates, and other news from Roxio.

The Help Menu

■ Contents: This option opens GoBack Help.

■ GoBack Drive Help: This option provides help with the 
GoBack Drive Window.

■ What's This?: To see a screen tip for a command button or 
screen region, click this option (or press Shift-F1) and then click 
the element you want information about.
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■ View User’s Guide: This option allows you to open this User’s 
Guide online.

■ About GoBack: The version number of GoBack is indicated 
here. If you need technical assistance, it is important to have 
this number available.

The Command Buttons
■ GoBack Menu: Displays the GoBack Main Menu.

■ Revert Drive: Reverts your hard disk to the way it was in the 
past, based on the time you selected. This option is equivalent 
to the Revert Drives option on the File menu.

■ Create GoBack Drive: Creates a GoBack Drive based on the 
time you selected in the GoBack Drive Window using the 
calendar and either the clock or Event List. This option is 
equivalent to the Create GoBack Drive at Selected Event option 
on the File menu.

■ Discard GoBack Drive: This option discards a previously 
created GoBack Drive. This option is equivalent to the Discard 
GoBack Drives option on the File menu.

Note: After you revert your hard disk using GoBack 
Deluxe Edition, the GoBack File Rescue Window 
displays. This window allows you to recover files 
changed or deleted after the time to which you reverted 
your hard disk. For more detail on this key function, see 
The File Rescue Window on page 7-2.
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Using the Right Mouse Button
In addition to making selections using the drop-down menus and 
the command buttons, there are several places where you can click 
the right mouse button to initiate an action.

Clicking on the right mouse button will display a list of options 
appropriate to each screen, depending on the location of your 
pointer when you right-click. If there is no option available at the 
location you’ve selected, you will be presented with the “What's 
This?” dialog as if you had selected it from the Help menu.
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The GoBack Shell Extension
With the GoBack Deluxe Edition, GoBack can be accessed in 
Windows Explorer by right-clicking a file. This provides a quick and 
easy way to retrieve or view older versions of a file. Technically, 
GoBack is providing a shell extension to Windows Explorer. You can 
use this to recover a file by replacing your existing document with a 
previous revision or save a previous revision with another file name.

The GoBack Shell Extension lets you access GoBack through 
Windows Explorer. After opening Windows Explorer or 
My Computer, find your particular file and right-click it and a 
shortcut menu will appear (as shown below).
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To see all the old versions of a file that GoBack has maintained, click 
Show Revisions next to the GoBack logo. A dialog box similar to the 
following illustration will appear:

Working with the File Version List
The file version list includes the versions of a particular file that 
GoBack has recovered. The list displays the original file name (since 
the file may have been renamed) along with the file’s size and the 
time at which it was saved.

Sorting the File Version List
Initially the list is sorted in reverse order by Original Time, with 
most recent versions at the top. You can click on each of the column 
headers to sort the list according to that column. By clicking on the 
column heading a second time, you can switch between ascending 
and descending order.

It is possible that some dates are initially out of order in the list. This 
occurs when an application modifies a file and then sets the 
modified date back.
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Selecting Past Versions of a File
From the File Version List, you may select one of your past versions. 
You can then select Open to view the file (and then possibly Save As 
within the file’s application to save the version under a new file 
name). Alternatively, you can select Recover to to copy the file to a 
drive without opening the file first. Note that the entry at the top of 
the list corresponds to the current version of the file (not an 
older one).

For step-by-step instructions see How do I get back a deleted or 
overwritten file? on page A-6.

The Command Buttons
■ Open: Click this button to open the selected file.

■ Recover To: Click this button to save the selected file.

■ OK, Cancel: Click OK or Cancel to close the window.
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Frequently Asked 
Questions
This appendix provides simple, easy-to-understand answers to 
many common questions. Chapter numbers relevant to the 
questions and answers are also provided so that you may refer to the 
more detailed information and pictures provided there.

How far back in time can GoBack retrieve data?

The length of time over which GoBack can recover data is 
determined by the amount of hard disk space allocated to GoBack 
and the intensity of computer usage. You can usually recover files 
for several days and possibly for several weeks. It all depends on 
how much data you are changing and how frequently it is changed. 
For example, programming and intense work with large graphics 
will use the space allocated to GoBack faster than word processing, 
or working in spreadsheets. With today’s hard disk drives becoming 
larger and less expensive, allocating part of your hard disk for 
GoBack will almost certainly lead to meaningful recovery ability.

You may wish to periodically check how far you can reach back in 
time (using the GoBack Drive Window in the Deluxe Edition) and 
adjust the allocated GoBack area accordingly. More space translates 
to a greater reach.

If massive amounts of data are altered, it is possible that your 
recovery ability will be limited, if available at all. After normal usage 
resumes, your recovery ability will usually start just after the 
massive change. For example, if at installation time, you set aside 
200 megabytes of disk space for GoBack, and subsequently 200 
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megabytes of data is loaded in a short period of time (for example, 
from CD-ROM), you will lose your recovery ability at that point in 
time. However, if you continue working and alter a 1MB file every 
10 minutes, working 8 hours a day, you will be able to look back as 
far as 4 days to any overwritten version of a file.

It is recommended that you continue to periodically back up your 
hard disk to protect against your hard disk actually breaking 
(physical hardware failure) as well as ensuring that you have 
complete snapshots of your data from specific points in time that 
will eventually be out of GoBack’s reach. 

What is MS-DOS Compatibility mode?

MS-DOS Compatibility mode is a mode in Windows 95/98/Me in 
which your hard disk(s) are not operating optimally using Windows 
32-bit drivers, but are instead using MS-DOS real-mode drivers.

If GoBack detects this condition, GoBack will not install or run. You 
must correct the problem before running GoBack.

There can be many reasons that a hard disk is running in MS-DOS 
Compatibility mode. These reasons include, but are not limited to:

■ An “unsafe” device driver, program, or virus loaded in 
Windows memory.

■ A hard disk controller not detected in Windows.

■ A conflict between the hard disk controller and another device.

■ An incompatible hardware device or configuration in 
Windows.

■ A damaged Windows driver.

Because GoBack does not cause the MS-DOS Compatibility mode 
condition, you must consult your hardware manufacturer for 
information about correcting the problem. You can also find many 
detailed articles about troubleshooting MS-DOS Compatibility 
mode problems in the support area on the Microsoft web site.

What happens when I upgrade my operating system?

Because GoBack connects into the operating system at a very low 
level, you should uninstall GoBack (using Add/Remove Programs 
in Windows Control Panel) before upgrading your operating system 
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or installing operating system service packs. After you complete 
your operating system upgrade, you can re-install GoBack 
(assuming you upgraded to an operating system that GoBack 
supports).

Do I still need to make backups?

Yes. GoBack complements a traditional backup by providing 
recovery ability to virtually any point within GoBack’s reach 
(typically, one week). It provides a window to the recent past to 
which you can easily jump back. You do not need to stop and make 
a traditional backup, in order to have this window available to 
correct a mistake. However, GoBack does not prevent data loss if 
your hardware actually breaks (for example, if your hard disk 
breaks down) or if the data you desire was altered long ago. This is 
where a traditional backup comes into play. Thus, GoBack 
complements your current backup process.

Remember, whether by way of a traditional backup, or going back in 
time using GoBack, the basic purpose of being able to restore data is 
to reduce the chances of having to spend a lot of time re-creating the 
information. The harder it would be to re-create important work, the 
stronger the steps you should take to protect it. It is common for 
extremely valuable information to not only make a traditional 
backup, but to make several backups, and place them at various off-
site locations (for example, in case of fire).

Will GoBack affect my computer’s speed?

In general, GoBack does not significantly impact your computer’s 
performance. Writing to your hard disk takes about the same 
amount of time, regardless of whether GoBack is installed or not. 
The work GoBack does in order to provide the ability to go back in 
time is generally done in the background. Since it mainly tracks 
writes, GoBack does not impact read times during most activities. If 
you are loading or modifying very large files (in relation to the disk 
space set aside for GoBack) such that useful recovery is no longer 
possible, GoBack automatically steps aside during this period and 
then resumes tracking as soon as possible. This accounts for why 
GoBack may complete hard disk activities when your system is idle. 
However, as soon as activity begins again—you save another large 
file—GoBack steps aside automatically.
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How does GoBack determine where to put Safe Points?

GoBack continually monitors all hard disk activity, and when it 
determines that nothing has been written to the hard disk for several 
seconds, it makes a note (a Safe Point) in its log. When you want to 
revert your hard disk, create a GoBack drive (Deluxe Edition), or 
recover a file (Deluxe Edition), GoBack lets you select these safe 
times, because you generally wouldn’t want to choose a time when 
you were in the middle of saving a file.

It’s important to note that if you perform several file activities in 
rapid succession, such as writing a file and then immediately 
deleting it, GoBack may not have written a Safe Point in the log. If 
this happens, you may not be able to select a time between these 
activities. To avoid this situation, pause between disk activities to 
allow the hard disk time to catch up.

How do I adjust the amount of space allocated to GoBack?

In order to make adjustments to the installation of GoBack, such as 
the amount and location of disk space allocated to GoBack, you 
must uninstall then re-install GoBack. Note that this will reset the 
information that GoBack has been tracking (GoBack History) and 
you will not be able to retrieve or revert back to the time before the 
uninstall. See Installing GoBack on page 2-3 for more information 
regarding disk allocation and the procedures for installation. 
Uninstalling GoBack is also a topic in this chapter.

How do I prevent others from looking at files that I have deleted?

If you work with confidential data or do not want others to be able 
to look at your hard disk as it was in the past, you can delete the 
data that GoBack has been collecting. Keep in mind, that after the 
GoBack History has been cleared, you can no longer view or retrieve 
data before this time.

To clear the GoBack History:

1 Open the GoBack Main Menu.

2 Click the Options button.

3 Select the drives you would like to clear.

4 Click the Clear GoBack History button.
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With GoBack Deluxe Edition, you can set GoBack Administrator 
and User passwords to prevent unauthorized users from recovering 
files from your GoBack History. See Passwords on page 4-7.

How do I view my hard drive as it appeared in the past?

See The GoBack Drive Window on page 8-3.

How do I create a GoBack Drive?

The following steps re-create a copy of a drive at the time of a 
selected event:

1 First, open GoBack by doing one of the following:

■ Click Start, Programs, then GoBack.

■ Click the GoBack icon in the taskbar.

■ Right-click the GoBack icon in the taskbar, then select one of 
the main GoBack functions from the shortcut menu.

■ Double-click the GoBack shortcut on the desktop (if 
available).

2 At the Main Menu on the Deluxe Edition, click the Advanced 
Features button. The GoBack Drive Window appears.

3 From the File menu, select the physical disk (one of your hard 
disks) from which you want to create the GoBack Drive(s). 

4 In the Event List, select the Windows Boot Point or System Safe 
Point on which to base the creation of the GoBack Drive. If the 
date that you wish to revert to does not show in the Event List, 
either click on the appropriate date in the calendar or use the 
scroll bar to move the list up or down. Also, if you know the 
approximate time you wish to go back to, you can type the 
time under the clock, which will move the Event List to the 
safe point nearest to the time you typed.

Note: For more information about GoBack Drives, 
including illustrations of the GoBack Drive Window, see 
Chapter 8
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5 Click the Create GoBack Drive button. A message box will 
appear indicating the drive has been created. A red box will 
appear around the date and the event from which you created 
the GoBack Drive. The GoBack Drive(s) will appear as an 
additional drive(s) in Windows Explorer.

6 Use Windows Explorer to access files on the GoBack Drive(s).

In Windows Explorer, the letter that follows the word 
“GoBack” indicates the original drive (based on the selected 
event) that was used to create the GoBack Drive. The drive in 
parentheses is the designation for the GoBack Drive.

How do I get rid of a GoBack Drive that I created?

After you have finished looking at or retrieving data from the virtual 
GoBack Drive you created, you should discard the GoBack Drive to 
save system resources.

1 Open GoBack by doing one of the following:

■ Select Start, Programs, then GoBack.

■ Click on the GoBack icon in the taskbar.

■ Right-click the GoBack icon in the taskbar, then select one of 
the main GoBack functions from the shortcut menu.

■ Double-click the GoBack shortcut on the desktop (if 
available).

2 From the Main Menu on the Deluxe Edition, click the 
Advanced Features button. The GoBack Drive Window 
appears. If your system includes multiple physical disks, the 
GoBack Drive(s) that will be discarded is for the currently 
selected disk as viewed in the Event List. If you wish to discard 
a different disk, select it in the File menu.

3 Click the Discard GoBack Drive button. A message box will 
indicate the drive(s) has been discarded.

How do I get back a deleted or overwritten file?

There are several ways to recover files using the GoBack Deluxe 
Edition. Two of them are described below.
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To recover files using the GoBack Main Menu:

1 Open GoBack by doing one of the following:

■ Select Start, Programs, then GoBack.

■ Click the GoBack icon in the taskbar.

■ Right-click the GoBack icon in the taskbar, then select one of 
the main GoBack functions from the shortcut menu.

■ Double-click the GoBack shortcut on the desktop (if 
available).

2 From the Main Menu, click the Recover Files button. The File 
Recovery Window appears.

3 From the File menu, select the drive your file is located on.

4 Select a file version from the list, then:

■ To recover the file, click Recover To, and select a title and 
location for this recovered version. If you do not wish to 
replace your current version, be sure that you have selected 
either a different title or a different location for this 
recovered version.

■ To view the file, click Open. The file is brought back from 
the past and stored in a temporary folder in 
...\GoBack\Temp. The appropriate application is then 
automatically launched to view the file. If it turns out that 
this is the version of the file you were looking for, then select 
File, Save As, and specify a name and location for this 
version.

To recover files using Windows Explorer (the shell extension):

1 From the Start menu, open Windows Explorer or Windows NT 
Explorer, depending on which operating system you are using.

2 Click on the drive containing your document.

3 Open the folders (and subfolders if needed) until you see the 
file you wish to view.

4 Right-click on your selected file.

5 On the shortcut menu, click Show Revisions.
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6 Sort the resulting dialog box, if necessary, by clicking on the 
column heading by which you wish to sort.

7 Select a file version from the list, then:

■ To recover the file, click Recover To, and select a title and 
location for this recovered version. If you do not wish to 
replace your current version, be sure that you have selected 
either a different title or a different location for this 
recovered version.

■ To view the file, click Open. The file is brought back from 
the past and stored in a temporary folder in 
...\GoBack\Temp. The appropriate application is then 
automatically launched to view the file. If it turns out that 
this is the version of the file you were looking for, then select 
File, Save As, and specify a name and location for this 
version. Upon exiting the application you will return to the 
Revisions dialog box at which point you may view another 
file version.

How do I revert my hard disk?

There are two ways to revert your hard drive. See Chapter 3 and 
Chapter 8 for more information. One method is outlined below:

1 Open GoBack by doing one of the following:

■ Select Start, Programs, then GoBack.

■ Click the GoBack icon in the taskbar.

■ Right-click the GoBack icon in the taskbar, then select one of 
the main GoBack functions from the shortcut menu.

■ Double-click the GoBack shortcut on the desktop (if 
available).

2 Open the Drive Revert Window.

To open the Drive Revert Window, click the Revert Your Hard 
Drive button on the GoBack Main Menu.

3 Select a time.

Users may select to revert to either one of the following three 
types of event-related times that display in the Event List:
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■ System Safe Point: This event, which is marked by a green 
arrow icon in the Event List, refers to a point in time when 
there was no system activity.

■ Start of System Boot: This event, which is marked by the 
GoBack logo in the Event List, refers to GoBack activities 
such as system boots and disk reverts.

■ Application Install: This event, which is marked by a 
computer monitor icon in the Event List, refers to when an 
application was installed on your computer.

Simply click an event-related time to select it.

4 Revert your hard disk.

To start Drive Revert, click the Revert Now button. GoBack 
reverts your hard disk back to the way it was just before the 
event you selected.

After a drive reverts, GoBack Deluxe Edition lets users rescue files 
using a window that displays automatically. For more on this, see 
The File Rescue Window on page 7-2.

How do I get back files after I have reverted my hard disk?

The File Rescue Window feature in the Deluxe Edition only displays 
after a drive revert has been completed. Once the File Rescue 
Window displays, it lets users open, review, and rescue any files that 
were changed or deleted after the time to which the drive was 
reverted.

File Rescue is easy to use. To use – just complete the following steps:

1 Revert your hard disk, and restart Windows.

When Windows restarts, the File Rescue Window displays 
automatically if a revert has occurred in the last hour. In 
addition, the File Rescue Window displays all files rescued 
from any reverts that were done over the last 24 hours.

For example, suppose you reverted your hard disk at 9 a.m. 
and the File Rescue Window displayed 20 files. If you 
continued working and reverted your hard disk at 4 p.m. that 
same day, when Windows restarted, File Rescue would display 
the 20 files from the first revert and any files that you changed 
or deleted after the first revert. So after the second revert, in 
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this example, File Rescue would display 30 files. Thus, File 
Rescue gives you a second chance to rescue any of the 20 files 
from the first revert and the normal option to rescue any of the 
10 additional files from the second revert.

2 Choose a file to rescue.

From the list of files that displays in the File Rescue Window, 
you have two options.

■ (Option 1) Click the Check Box in front of a file and then 
click the Open button. When the file opens, decide whether 
it is a file you want to rescue. If you want to rescue the file, 
choose Save As from the File menu that displays and save 
the file to a desired location. If it is not the file you want to 
rescue, simply close the file.

■ (Option 2) Click the Check Box in front of a file and then 
click the Rescue Files button. The file, or files, you selected 
is rescued and saved automatically to the location where it 
was originally saved! (Option 2 assumes that you know you 
want to rescue the file.)

How do I view all the recent versions of a Microsoft Word document?

To view (and recover, if desired) your most recent versions of your 
Word document (GoBack Deluxe Edition only):

1 Open Windows Explorer or My Computer.

2 Click the drive containing your document.

3 Open folders (and subfolders if needed) until you see the file 
you want to view.

4 Right-click on your selected file.

5 On the shortcut menu that appears, click Show Revisions.

6 Sort the resulting dialog box, if necessary, by clicking on the 
column heading you wish to sort by.

7 Select the version.
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8 Click Open to view the file. This brings the file forward in 
time, saving it in a temporary folder, and launches Word so 
that you may view the file. To save the file, select File, then 
Save As, and select a name and location. You may also click 
Recover To in order to save the file without viewing it.

For more information on this, see The GoBack Shell Extension on 
page 9-2.

How do I start my computer when it’s “locked up”?

When you are unable to start your computer normally, you can 
perform an emergency recovery from the GoBack Boot Screen. See 
Chapter 3 for more information.

To revert your hard disk from the GoBack Boot Menu:

1 Restart your computer (using either the power switch or reset 
button).

2 When the GoBack Boot Screen appears, press the spacebar. The 
GoBack Boot Menu will appear.

3 From the GoBack Boot Menu, click Revert Drive. GoBack will 
search your physical hard disk for safe times (when your hard 
disk was idle) to which to revert. GoBack identifies safe points 
and displays them in a dialog box. You can select a time and 
click Revert, click More Times to see other possible times, or 
cancel the revert request.

After you have selected one of the revert time options GoBack 
offers, your system will restart and try to boot. (Remember, do 
not press the spacebar the second time through the boot 
process.)

4 If your computer still will not start correctly, repeat Step 1 
through Step 3 and select a different time to revert to.

How do I use the floppy disk that came with a game or other program?

To boot from a floppy disk:

1 Start the computer without the floppy disk in the drive.

2 When the GoBack Boot Screen appears, press the spacebar. 
This brings up the GoBack Boot Menu.
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3 Put your program’s floppy disk in the floppy drive.

4 From the GoBack Boot Menu, select Boot from Floppy. Your 
computer will now start booting from the floppy.

For more information, see The GoBack Boot Screen on page 3-2.

How do I disable GoBack?

There are a few occasions when you may want to disable GoBack:

■ When you wish to boot up using an alternate operating system 
and want to access files normally protected by GoBack.

■ Before using disk-partitioning software to modify your disk 
partitions.

■ When upgrading or re-installing your operating system.

To disable GoBack from within Windows (see Using the GoBack Boot 
Menu on page 3-4, for more information about the Options button):

1 From the GoBack Main Menu, click Options.

2 From the GoBack Options dialog box, click Disable GoBack.

To disable GoBack from the GoBack Boot Screen (see Disabling 
GoBack on page 3-7 for more information regarding the Boot Screen):

1 Press the spacebar when the GoBack Boot Screen appears.

2 From the GoBack Boot Menu, select Disable GoBack.

Note: Remember, GoBack will not track any information 
while it is disabled. The Disable GoBack option also clears 
all GoBack History so that you will not be able to revert 
any disks, view, or retrieve any old files from the time 
before GoBack was disabled.
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How do I uninstall GoBack?

The following steps will remove the application from your hard disk 
and release all allocated storage on all physical drives:

1 Click Start, select Settings, then Control Panel.

2 In Control Panel, double-click the Add/Remove Programs 
icon.

3 At the Add/Remove Programs Properties dialog box, select 
GoBack from the list of installed applications and click the 
Add/Remove button.

4 Follow the on-screen instructions.

The system will reboot to complete the uninstall.

How do I use GoBack with MS-DOS?

GoBack can continue to protect your hard disk(s) while you run an 
MS-DOS-based window while still in Windows. Note that GoBack 
may prevent some MS-DOS disk utilities from modifying protected 
areas of the hard drive.

I did not see my question here. Where can I find more information?

If you need further assistance, please open your browser, and locate 
a local version of the Roxio web site.

WARNING: Be sure to use Windows Add/Remove Programs 
to uninstall GoBack. Never use a third-party uninstaller or 
allow a third party utility to monitor the uninstall process. 
Uninstall utilities cannot properly remove GoBack from 
your system.
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Boot Time

The initial period when your computer is starting is referred to as its 
boot time. When you restart your computer, a new boot is initiated.

GoBack Drive

A GoBack Drive looks and is used like any other drive (such as your 
floppy drive) but it is created using GoBack. Unlike a physical drive, 
a GoBack Drive does not actually exist—its contents are generated 
by GoBack, based on the way your hard drive was at some selected 
time. You can use a GoBack Drive to retrieve or view earlier versions 
of your files.

GoBack History

In order for GoBack to provide the ability to go back in time, it 
makes notes about changes occurring on your computer. These 
notes, stored in an area on your hard disk, are referred to collectively 
as the GoBack History. The location and size of the GoBack History 
is established during installation.

Note: Although you can write to a GoBack Drive, any 
changes will be lost when the drive is discarded (or when 
Windows is shut down).
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Logical Drive

A logical drive results from partitioning a physical drive into 
separate, smaller drives. For example, one physical disk may be 
divided into two logical drives, C: and D:.

Physical Disk

This is the physical hard disk drive that is interfaced to your 
computer. Physical disks may be partitioned into one or more logical 
drives.

Recover

This is the process of retrieving a file that existed at some point in 
the past and saving it to the present.

Rescue (File)

This is the process of opening, reviewing, and rescuing any files that 
were changed after the time to which a drive was reverted. The File 
Rescue Window, only available in the Deluxe Edition, displays 
automatically only after the revert hard drive option has been 
completed and the user has logged back into Windows.

Revert

This is the process of changing an entire physical disk to the way it 
was at some point in the past. If there is more than one logical drive 
on the physical disk, all of the drives will be reverted 
simultaneously.

Safe Point

This is a moment in time that GoBack has determined the hard disk 
is stable, meaning that all of the data on the hard disk is in a 
consistent state. Safe points are the times at which a GoBack Drive 
can be created or to which a hard disk can be reverted.

Shell Extension

GoBack provides additional functionality to Windows Explorer 
through the standard means of a shell extension.
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Virtual Drive

A fake disk drive emulated with software. GoBack Drives are virtual 
drives that show how the actual drives appeared in the past.

Windows Explorer

This application is provided with Windows operating systems. It 
lets you, among other things, view, copy, and delete files that are on 
the various hard drives connected to your computer.
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